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Introduction
This manual describes installation and operation of the LeCroy  
Sierra M6-4™ Protocol Analyzer and includes examples of typical applications.

Figure  1  LeCroy Sierra M6-4 Protocol Analyzer

Analyzer Overview
The Sierra M6-4 SAS/SATA Protocol Analyzer is a serial bus analyzer, supports host 
and device emulation, and provides error injection functionality. The SAS analyzer 
software performs serial bus analysis for Serial Attached SCSI (SAS) data transfers, 
as well as Serial ATA (SATA) data transfers through STP data transfers. The SATA 
analyzer software performs serial bus analysis for Serial ATA (SATA) data transfers.

The Sierra M6-4 Analyzer helps Hardware, Firmware, Design, and Application 
Engineers troubleshoot and diagnose SAS and SATA problems within their product. 
The analyzer supports the following:

• Capture, triggering, and filtering of Serial Attached SCSI packets or Serial ATA 
packets

• Generation of bus traffic as a SAS Initiator Emulator or a SATA Host Emulator, 
while monitoring and analyzing results

• SAS target emulation and SATA device emulation
• Running a Pattern Generator
• TX Vout on transmitters for test and characterization 

The analyzer provides for bi-directional trigger and capture of commands, primitives, 
patterns and all bus conditions. You can capture all frames and/or exclude traffic. 

The Sierra M6-4 Analyzer has a USB port and an Ethernet port to connect to a 
computer. You can cascade analyzer units for higher port counts. You can trigger 
manually or trigger on a specific event.

The Sierra M6-4 Analyzer provides a full range of views and statistical reports.
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Receiving Your Analyzer
The analyzer package includes the following components:

• 1 Sierra M6-4 Analyzer identified in the packing list
• 1 MiniSAS to 4-x1 SATA straight cable, 1 meter
• 1 MiniSAS to 4-x1 SATA crossover cable, 1 meter
• 2 mSAS to mSAS cables, 1 meter
• 2 mSAS to SAS x4 cables, 1 meter
• 1 USB A-B 2.0 cable, 1.8 meter
• 1 Ethernet cable, 10 feet
• 1 10-position ribbon cable, 6 inches
• 1 SMB RA to SMB RA cable, 6 inches
• 1 Three-Prong AC power cord
• 1 Installation CD ROM with software and documentation
• 1 Sierra M6-4 Getting Started manual

Unpacking the Analyzer
Inspect the received shipping container for any damage. Unpack the container and 
account for each of the system components listed on the accompanying packing list. 
Visually inspect each component for absence of damage. In the event of damage, 
notify the shipper and LeCroy Corporation. Retain all shipping materials for shipper’s 
inspection.



Introduction

3

Analyzer Features
The Analyzer has the following features:

• Power Switch
• Frame, Speed, Link, Error, and Trigger LEDs
• External Trigger Input and Output
• Initiator and Target mini-SAS connectors (4)
• Expansion In/Out data ports and Clock In/Out connectors
• Status and Configuration LCD Display
• USB port for host connectivity
• Ethernet port for network connectivity
• Power In (on back)

Figure  2  Front Panel



Introduction

4

LEDs
LEDs support each port link, with the following functionality:
FRAME/OOB Before the link is established, illuminates during the OOB sequence.  
Green After the link is established, indicates traffic on the bus.
SPEED Illuminates as follows:  
Orange

Speed    Initiator Target
1.5G Off Off
3.0G On Off
6.0G On On

LINK Illuminates when a link is established. 
Yellow
ERROR Illuminates when an error occurs. 
Red
TRIGGER Illuminates when a trigger occurs. 
Blue

Figure  3  LEDs

Status and Configuration Display
The Analyzer front LCD display indicates the configuration and status of operations. 
For example, during initialization, the LCD panel displays boot status messages.
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Installing Your Analyzer
Software Installation

The software works on systems using the Windows® XP operating system.

Do not connect! Do not connect Sierra M6-4 to your host system until software installation is 
complete.

1. Insert the Installation CD ROM into the CD drive on the host machine.

2. The installation automatically starts setup, unless Auto Run is off. In that case, 
select the CD ROM from “My Computer” and click Setup.

3. After the warning to close all other programs and before starting the installation, 
the Install component selection opens.

4. Select components for installation.

5. Click Next to complete the installation.

System restart
You must restart your computer before you can use your Analyzer software.

Error Message
If you get an error message during installation of the drivers for Window, consult your 
system administrator. Your system may allow only administrator-level users to copy 
such driver files.
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Hardware Setup
Separate Systems

When using the analyzer, it is recommended to use a system to generate bus traffic 
and a second system to run the software, to avoid characterization of analyzer traffic.

Connecting in General
Note: You must install the software before connecting the analyzer to the host 
machine for the first time.

To set up the analyzer:

1. Connect the analyzer to a 100V–240V, 50Hz–60Hz, power outlet and turn on the 
Power switch. 
At power on, the analyzer will go through initialization as shown on the LCD 
display.

2. Connect the USB cable between the Sierra M6-4 USB port and a USB port on the 
Host PC. The host PC operating system detects the analyzer and driver files.

3. Connect the analyzer as shown in Figure 4:

Figure  4  Analyzer Connections

Analyzer

       HBA   Hard Drive

crossover straight
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Cables to Use
When using Sierra as a Host Emulator, connect from Target to hard drives using an 
iPass to SATA octopus Straight cable. 

When using Sierra as a Device Emulator, connect from Initiator to HBAs using an 
iPass to SATA octopus Crossover cable. 

When connecting between a HBA and a disk drive, use a crossover MiniSAS (iPASS) 
from the initiator port on the Sierra to MiniSAS or SAS4X cable depending on the HBA 
connector, and a MiniSAS from the target port to SATAx4, connecting the SATA 
connector to the disk drive.

Figure  5  Sierra M6-4 Connected as an Analyzer
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Expandability
You can use cascading of analyzer units for higher port count, by daisy chaining the 
units through the provided Expansion and Clock In/Out interfaces on the analyzer 
front. Connect “Out” connectors to “In” connectors of the next unit in the chain, for 
both Signal and Clock interfaces. You must provide external hubs for connecting the 
host PC to these units using USB or Ethernet. You can cascade up to eight units.

Cascading
To set up the units in a cascade:

1. Connect all units to the Host PC using either USB or Ethernet cables. You can use 
hubs.

2. Locate the Expansion and Clock ports on the front of each unit.

Figure  6  Expansion and Clock Ports on Front Panel
3. Connect the OUT Clock connector of Unit 1 to the IN Clock connector of Unit 2 

using the supplied stacking cables. Similarly connect any additional units.

Figure  7  Expansion and CLOCK Ports
4. Connect the OUT 10-pin connector of Unit 1 to the IN 10-pin connector of Unit 2 

using the supplied stacking cables. Similarly connect any additional units.
Note: Unit 1 must be the unit that has the first out connection.

Figure  8  Cascading

  Expansion      Clock

    In      Out   Out  In

     In               Out            In      Out

         Expansion                Clock
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5. Make a note of the last four digits of the MAC address of the unit designated as 
Unit 1 and the last four digits of the other units, in order of connection.

Figure  9  Address Digits

Important! Power up all units before starting the software.

After you start the software, the software searches for and displays all connected units 
in the Select Device dialog. 

Figure  10  Select Device Dialog

If you have multiple devices, you can check the Multilink Analyzer check box.

You must compare the addresses in the Device ID field to the addresses you noted in 
step 5 above. 

To match your unit sequence to the address for each unit in the Select Device dialog, 
click the pull down tab under the Order heading (not shown, but on the right side) and 
select unit numbers: 1 for Unit 1, 2 for Unit 2, and so on. 

Then click OK and let the software initialize.

Important! Power up all units before starting the software.
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Connecting via Ethernet
The Ethernet connection can have any of these configurations:

1. Analyzer connected to a network using a hub, switch, Gigabit Ethernet interface, or 
similar device.

2. Analyzer connected to the host computer (machine running the application 
software), using a hub, switch, Gigabit Ethernet interface, or similar device.

3. Analyzer connected directly to the host computer using a crossover cable. 

Connecting to a Network
When connected to a network, the analyzer can communicate with the DHCP server 
to establish a connection. The DHCP server continually sends the next available 
IP address to the analyzer until the software starts. 

Connecting using a Hub, Switch, or Similar Device
When connected to the host machine using a hub, switch, Gigabit Ethernet interface, or 
similar device, the Analyzer must communicate with the host computer to establish a 
connection. The host computer continually broadcasts the next available IP address 
to the Analyzer, until the software starts. 

IP Address
When you start the software, the Device Selection dialog appears. 

Figure  11  Device Selection Dialog
To look for local devices on the Ethernet, select the Ethernet check box.
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The Internet Protocol (TCP/IP) Properties dialog may prompt you to automatically use 
the offered IP address or to assign a specific IP address. (The assigned IP address 
must be on the same network segment as the host computer.) 

Figure  12  Internet Protocol (TCP/IP) Properties
The menu also allows you to save the selected option (automatic or specific address).

If the assigned IP address is not available, the OS notifies you of an IP address 
conflict.

After you click OK, the software searches for all analyzers connected to the network 
and displays a list of available units in the Select Device dialog.

Figure  13  Select Device Dialog
After you select a unit, the software assigns the IP address to the selected unit, 
completing the connection, then launches the software.
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Connecting over Different Subnets
If the Host PC (with the Sierra software) and Sierra M6-4 are on the same subnet, 
they will see each other’s broadcasts, and the Sierra M6-4 application will 
automatically appear in the Select Device dialog, from which you can select a device 
(as described in the previous section).

If the Host PC and Sierra M6-4 do not reside on the same subnet, they will not see 
each other automatically. You must add the Sierra M6-4 IP address manually. When 
you start the software, the Device Selection dialog appears.

Figure  14  Select Device Dialog
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In the Device Selection dialog, select Remote Devices and click OK to open the 
Remote Connection Settings dialog. 

Figure  15  Select Device Dialog

To set the remote connection settings:
1. Enter the Server IP Address or Server Host Name.
2. Enter the Port Number or use the default. 
3. (optional) Select the Internet Remote Connection check box if the connection 

uses the Internet. 
4. (optional) Enter a Security Code.
5. Click OK.

The Sierra application on the Host PC will send a connection request to that 
IP address.
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Launching Your Analyzer
To launch the software, double-click the SAS or SATA Icon in the Program Manager 
Window.

Establish Interface
The first time you run your software, the software displays the Device Selection dialog. 

Figure  16  Device Selection Dialog

Select an interface:

• Local devices: Connected by USB and/or Ethernet (see “Connecting via 
Ethernet” on page 10)

• Remote devices: Available in the Remote Connection Settings dialog (see 
“Connecting over Different Subnets” on page 12)

• Simulation Modes: Hardware Not Installed or STX-131 (see “Operating in 
Simulation Mode” on page 15) 

Click OK to display the software.
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Operating in Simulation Mode
The system operates in Simulation Mode by default if the software detects no 
hardware. However, you can operate in Simulation Mode directly, without installing 
the Analyzer hardware. To operate without hardware, select Hardware Not Installed 
(Simulation Mode) in the Device Selection dialog box and click OK.

The Analyzer software launches and displays the appropriate tool bar, but with the 
limitation that the Analyzer operates only on static, previously captured, bus data.

Limitations Simulation Mode lets you try all of the available functions, but the 
system is not capturing any real data and is displaying only  
pre-captured results.
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Using the Software
The Sierra M6-4 application has the LeCroy SAS Protocol Suite and the 
LeCroy SATA Protocol Suite. 

The LeCroy SAS Protocol Suite can be a:
• Protocol Analyzer: Captures data, triggers on events, and saves. Easy Mode 

allows standard Trigger and Data capture. Advanced Mode allows you to 
program custom triggering in and out, capturing, state jumps, and timers (see 
“Protocol Analysis” on page 19).

• Protocol Analyzer Initiator Emulator: Generates bus traffic for capture. It also 
has Easy Mode and Advanced Mode (see “Exercise and Capture” on page 78).

• Target Emulator: Acts as target (see “Target and Device Emulation” on 
page 121).

The LeCroy SATA Protocol Suite can be a:
• Protocol Analyzer: Captures data, triggers on events, and saves. Easy Mode 

allows standard Trigger and Data capture. Advanced Mode allows you to 
program custom triggering in and out, capturing, state jumps, and timers (see 
“Protocol Analysis” on page 19).

• Protocol Analyzer Host Emulator: Generates bus traffic for capture. It also has 
Easy Mode and Advanced Mode (see “Exercise and Capture” on page 78).

• Device Emulator: Acts as device (see “Target and Device Emulation” on 
page 121).

Protocol Analyzer
To use the software for protocol analysis, first select File > New > Protocol Analyzer 
for a new project or File > Open an existing protocol analysis file: .sac for a SAS file 
or .stc for a SATA file (see “Protocol Analysis” on page 19). You can also open a .scs 
SAS Sample file or .sts SATA Sample file. Example files are in the Examples folder. 
You can also use Project Setup > Last Protocol Analyzer.

In Easy Mode, on the Capture tab, select to capture Everything or Pattern. For 
Pattern, select a Pattern. You can exclude patterns and frames. You can use different 
patterns for pre-trigger and post-trigger.

In Easy Mode, on the Trigger tab, select the trigger type. For Pattern, select the 
pattern.

In Easy Mode, on the Settings tab, select trigger position and memory use. 

Change the Analyzer settings if necessary. Change the port Speed if necessary.

Use Advanced Mode only after you become familiar with the hardware and software 
and have special needs.
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Protocol Analyzer Initiator Emulator or Host Emulator
To use the software for protocol analysis to generate host traffic, first select File > 
New > Protocol Analyzer Initiator Emulation or Protocol Analyzer Host 
Emulation for a new project or File > Open an existing Pattern Generator file: .spg 
for a single-role file (see “Exercise and Capture” on page 78). 

In Easy Mode, on the Initiator Emulator or Host Emulator tab, insert instances of ATA, 
SCSI, TASK, SMP, Frame, or Event. Select the type of each from the drop-down lists. 
You can also loop, go to, wait, delay, if...then, and stop.

In Easy Mode, on the Capture tab, select to capture Everything or Pattern. For 
Pattern, select a Pattern. You can exclude patterns and frames. You can use different 
patterns for pre-trigger and post-trigger.

In Easy Mode, on the Trigger tab, select the trigger type. For Pattern, select the 
pattern.

In Easy Mode, on the Initiator Setting or Host Setting tab, select the port and speed. 
Select to run the Pattern Generator or Initiator Emulator or Host Emulator.

In Easy Mode, on the Settings tab, select trigger position and memory use. Also 
change the Analyzer settings if necessary. Specify addresses, stops, times, and 
sizes, if necessary.

Use Advanced Mode only after you become familiar with the hardware and software 
and have special needs.

Target Emulator or Device Emulator
To use the software as a target or device emulator, first select File > New > Target 
Emulator or Device Emulator for a new project or File > Open an existing Emulator 
file: .std Target Emulator file or .sde Device Emulator file (see “Target and Device 
Emulation” on page 121). You can also use Project Setup > Last Target Emulator or 
Last Device Emulator.

In the Pages tab, change settings for the supported pages if necessary.

In the Error Injection tab, select General periodic errors, Identify frames, 
Connection Management open and close connection errors, SAS Commands and 
events errors, ATA Commands errors, or SATA Signature content.

Use the User-defined Commands tab only after you have become familiar with 
operations.

In the Settings tab, select addresses, sizes, times, and ports, if necessary.

You can capture traffic when using an Analyzer project (but not a Target Emulator 
project). With a Protocol Analyzer open, open a Target Emulator. After checking the 
settings, click the Activate/Deactivate (Active) device button. or select Project Setup 
> Active Device. If you change Target Emulator settings, Deactivate and then 
Activate Device.
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Viewing Captured Data
After data capture, the captured data is in the Viewer (see “Display Manipulation” on 
page 149). You can display the same data in:
• Packet View: Shows packets.
• Text View: Shows transaction frames, grouped in columns by port.
• Column View: Shows DWORDS in columns by port.
• Spreadsheet View: Shows Packet View fields by time.
• Histogram View: Shows frame-type transfers.
• Waveform Display: Shows waveform display for all active ports, on which you 

can perform timing measurements.
• Data View: Displays data payloads.
You can show or hide fields and ports, change port names, and change data format.
You can show the layers and channels using their toolbars.
You can decode using the Decode toolbar.
You can Search and Filter.
Configuration
For special work, you can use the Configuration menu to configure Data Blocks, 
Software Settings, and TxVout & Pre-emphasis (see “Display Configuration” on 
page 192).

Port Status
You can display an overview of the active ports by clicking the buttons at the bottom 
right of the main window (see “Port Status” on page 164).

Statistical Reports
You can generate statistics for all transports, commands, primitives, bus conditions, 
addresses, lanes, and errors (see “Statistical Report” on page 208).

Data Report
The data report displays all the data sent from the host to the device and from the 
device to the host (see “Data Report” on page 229).

Infusion
The LeCroy Infusion™ Error Injector and Traffic Modifier is an error injector and traffic 
modification tool that allows you to verify real-world fault handling for 
Serial Attached SCSI (SAS) and Serial ATA (SATA) systems (see “Infusion Overview” 
on page 243).

Next Chapter
To start working with the protocol analyzer and software, go to “Protocol Analysis” on 
page 19.
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Protocol Analysis
The system performs Protocol Analysis by defining and running an analysis project. 
An analysis project definition defines what to capture, what the analyzer triggers on, 
and the memory settings. You can save defined projects as project *.sac files for later 
use.

Easy Mode (Pre-Defined Setups)
After you install the Analyzer software (see “Software Installation” on page 5) and set 
up the Analyzer (see “Hardware Setup” on page 6), launch the Analyzer software (see 
“Launching Your Analyzer” on page 14) to display the default Protocol Analyzer in 
Easy Mode at the Capture tab.

This mode allows you to operate the analyzer with minimum setup. In this mode, you 
can perform only a Trigger and Data capture, or you can program the 
SAS Initiator Emulator or SATA Host/Device Emulator to generate bus traffic for 
triggering and data capture.

Main Window
Use Easy Mode to get a comprehensive overview of your analyzer’s capabilities:

SAS: On the Analyzer Menu Bar, click File > New > Protocol Analyzer to open a 
SAS Protocol Analyzer dialog.

Figure 17. SAS: New Analysis Project Dialog

Project Tree display 

What analyzer triggers on

Capture memory settings

Collapse All button hides details in Project Tree
Expand All button expands collapsed Project Tree
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The New Project dialog opens with default settings to capture Everything on the bus 
and to Trigger On on Snapshot. (The analyzer captures everything immediately 
without triggering on anything in particular.)

SATA: On the Analyzer Menu Bar, click File > New > Protocol Analyzer to open a 
SATA Protocol Analyzer dialog.

Figure 18. SATA: New Analysis Project Dialog
SAS vs. SATA: SATA Dialog does not show “Exclude RRDY” or “Exclude NOTIFY”. 
SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”.

Project Tree
The Project Tree on the right side of the main window displays a comprehensive tree 
structured overview of the project. The project tree shows what to capture, on what 
the analyzer triggers, and the capture memory settings.

Project Tree display 

What analyzer triggers on

Capture memory settings

Collapse All button hides details in Project Tree
Expand All button expands collapsed Project Tree
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Capture Tab Fields
The Capture tab has the following fields:

Exclude SATA_CONT (SAS) or Exclude CONT (SATA) 
Check this to exclude SATA_CONT primitives from the data capture.

Exclude SATA_SYNC (SAS) or Exclude SYNC (SATA) 
Check this to exclude SATA_SYNC primitives from the data capture.

Exclude OOB Signals 
Check this to exclude OOB signals from the data capture.

Exclude XXXX 
Check this to exclude XXXX patterns from the data capture.

Exclude Payload except 
Check this to exclude Payload of Data Frames from the data capture. You can except 
a number of Dword(s).

Exclude ALIGN 
Check this to exclude ALIGN primitives from the data capture.

Exclude RRDY (SAS only) 
Check this to exclude RRDY primitives from the data capture.

Exclude NOTIFY (SAS only) 
Check this to exclude NOTIFY primitives from the data capture.

Exclude Idle 
Check this to exclude Idles from the data capture.

Define different patterns for pre-trigger and post-trigger data captures 
Replaces the Capture tab with a Pre-Trigger Capture tab and a Post-Trigger Capture 
tab.
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SAS Software Menus and Toolbar
The SAS software has the following menus and main toolbar. 

Figure 19. SAS: Software Menus and Toolbar

Infusion: The toolbar adds the  Infusion button, which displays the Infusion error 
injection window.

SATA Software Menus and Toolbar
The SATA software has the following menus and main toolbar.

Figure 20. SATA: Software Menus and Toolbar

Open Sample File

Open Last Saved Protocol Analyzer Open Last Saved Performance Analyzer Project

Open Last Saved Target Emulator

               Abort Capturing Without Saving Sample File
                  

              Activate/Deactivate Device (Target Emulation) 

Open Find Device Dialog

Stop Hardware
                  Data
                 Block

(not available for Sierra M6-4 or STX-460) 

Open Sample File
Open Last Saved Protocol Analyzer Open Last Saved Performance Analyzer Project

Open Last Saved Device Emulator

               Abort Capturing Without Saving Sample File

              Activate/Deactivate Device (Device Emulation) 

Open Find Device Dialog

                                                                   Stop Hardware

(not available for Sierra M6-4 or STX-460) 
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Run Hardware
To get an immediate overview of the bus traffic to and from your Analyzer:

1. Click the  Record button.

2. The analyzer begins filling the defined memory buffer with traffic on the bus. 
After the traffic fills the memory buffer, the traffic is uploaded to the viewer and 
the Packet View display opens. Packet View is the default display. However, 
you can view results in any of the different views by selecting View on the menu 
bar and choosing the desired View. 

Figure 21. SAS: Typical Packet View Results Display
SAS: In case of an STP interface, the expander displays STP addresses provided to 
the SATA drive and the SAS software integrates the STP addresses in the ATA 
command.

The results display shows each transaction for every layer identified in a different color 
and the data direction identified with data direction arrows. Upstream traffic has an 
arrow from right to left: ⇐. Downstream traffic has an arrow left to right: ⇒.

You can hide any layer by clicking the corresponding Show/Hide button on the menu 
bar. The system retains all captured data, but the display has only some data layers 
for simpler viewing.

You can configure the viewer display for test and viewing preferences (see “Viewer 
Display” on page 149 for details about configuring the viewer display).

Layer ID with different colors

Data direction arrows

X,Y,T
Cursors

Show/Hide Layers buttons

Relative time display
(Between two sequential packets

Source and destination addresses in SCSI commands

Transport Layer command interpretation

Not shown in this capture

Show/Hide Port Data

Link 
Layer

on the same layer and port)
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The Analysis Project dialog offers you a comprehensive set of choices to create a 
trigger and capture project satisfying some specific need. You can set the Analyzer to:

• Capture specific patterns (see section  "Patterns and Data Capture Setup").
• Capture different patterns pre- and post-trigger.
• Exclude parameters from capture.
• Trigger on a pattern or sequence of patterns (see section  "Trigger Setup").
• Configure trace capture memory (Settings tab).
• Select file to save trace capture in memory (Settings tab).
• Include a project note (Notes tab).

Saving a Trace Capture
You can save a Trace Capture for review at a later time using the Save As dialog. 

Figure 22. Save As Dialog
You can limit the range of the saved file. You can save:

• All Samples
• a range between selected cursors
• a range between selected Idle, link, commands
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Projects
You can define a new project, starting with the default project definition, or modify the 
settings for the last project run.

New Default Project 
To start a New project, select File > New on the main menu bar and choose 
Protocol Analyzer to open a new project with default settings that you can modify 
(see “Main Window” on page 19).

Last Project 

Clicking the Green button opens the last project run, so you can modify it.

Project File Types
Projects have the following file types:
*.asl Decoding script file (in the Examples folder “User Define Decoding Script” 

subfolder)
*.cfg Display Configuration file (in the System folder “Config” subfolder)
*.dat DataBlock file (in the System folder “DataBlock” subfolder)
*.sac SAS Protocol Analyzer/Capture Project/Viewer file (in the Examples folder 

“EasyCaptr”, “AdvanceCaptr”, or “Exerciser” subfolders)
*.saf Device Identifier file
*.scs SAS Sample file (in the SAS Examples folder “Sample” subfolder)
*.sde Device Emulator file (in the System folder “Compliance” subfolder)
*.sfl Filter configuration file
*.spg Single-role Pattern Generator file (in the Examples folder 

SAS “PatternGenerator\Single role (spg files)” subfolder and 
SATA “PatternGenerator\Single Role” subfolder). Single role means the file is 
for a Device or Host.

*.ssh SAS Search configuration File
*.stc SATA Protocol Analyzer/Capture Project/Viewer file (in the Examples folder 

“EasyCaptr”, “AdvanceCaptr”, or “Exerciser” subfolders)
*.std Target Emulator file (in the Examples folder “Target Emulator” subfolder)
*.sts SATA Sample file (in the SATA Examples folder “Sample” subfolder)
*.tsh SATA Search configuration file
*.wss SAS Workspace file (in the SAS System folder “Predefined\Workspace” 

subfolder)
*.wst SATA Workspace file (in the SATA System folder “PreDefined\Workspace” 

subfolder)

Example Projects
The Analyzer includes example projects that you can use to perform an immediate 
analysis without any setup.

The Analyzer system software has a pre-defined folder (directory) structure for storing 
all files. All example files are in the Examples folder under the Sierra M6-4 folder.
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It is strongly recommended that you open some example files to see types of projects 
that you can create.

Run an Example Analysis Project
To run an example project:

1. Select File > Open.
2. Locate example analysis projects by looking in the Examples folder. Examples 

are available for AdvanceCaptr, EasyCaptr, Exerciser, PatternGenerator, 
Samples, Target Emulator, and User Define Decoding Script.

3. In the EasyCaptr folder, choose an example *.sac file and click Open to display 
the example project dialog.

Figure 23. File Open Dialog
 

Figure 24. SAS: Sample Protocol Analysis Project
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SAS vs. SATA: For Pattern Parameters, SATA Dialog adds FIS, FIS Pattern, and 
ATA Command Pattern and does not have STP Frame, SSP Frame, SMP Frame, and 
Address Frame.

4. Click the Record button to execute the pre-defined example.

5. After the project runs, you see an analyzer trace capture display similar to the 
one shown in Figure 25. 

Figure 25. SAS: Analyzer Trace Capture Display
For details about the results display, see “Display Manipulation” on page 149 and see 
“Display Configuration” on page 192.
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Patterns and Data Capture Setup
You can refine data capture by choosing Pattern and then selecting specific patterns 
for capture. Additionally, you can define a different set of patterns to capture after 
trigger.

To define specific patterns for capture, click the Pattern button to display the 
Capture tab for Pattern. 

Figure 26. SAS: Choosing Capture Patterns
SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” 
and “Exclude SATA_SYNC” with “Exclude SYNC”. 

SAS: The SAS Parameters window displays the following pattern capture categories:
• STP Frame
• Address Frame
• SMP Frame
• SSP Frame
• Data Pattern
• Protocol Errors

SATA: The SATA Parameters window displays the following pattern capture 
categories:

• FIS
• FIS Pattern
• Data Pattern
• Protocol Errors
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Choose a Parameter
To choose a parameter for capture from any of these categories, highlight the 
category in the parameter window and click the Add>> button. This opens selection 
dialogs for each of the categories displaying all of the parameters for that category. All 
patterns added appear in the Project Tree.

Exclude Patterns
Check this box to allow for the capture of everything except the patterns that have 
been added to the Project Tree. 

When you check this box, the Primitive category appears in the Parameter window, 
and the window enables the Exclude Idle checkbox.

Figure 27. SAS: Exclude Patterns Checked
SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” 
and “Exclude SATA_SYNC” with “Exclude SYNC”. SATA Dialog has different Pattern 
Parameters (see “Patterns and Data Capture Setup” on page 28).

To remove an item from capture, highlight it in the Project tree and click the 
<<Remove button.
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Pre and Post Trigger Data Capture
You can define one set of patterns for capture prior to the occurrence of a trigger and 
another set of patterns for capture after the occurrence of a trigger. The selection and 
setup procedure is the same for both Pre-Trigger capture and Post-Trigger capture. 

Check Define different patterns for pre-trigger and post-trigger data capture to 
enable the Pre-Trigger Capture and Post-Trigger Capture tabs (instead of only the 
Capture tab).

Figure 28. SAS: Post-trigger Capture Dialog Enabled
SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” 
and “Exclude SATA_SYNC” with “Exclude SYNC”. SATA Dialog has different Pattern 
Parameters (see “Patterns and Data Capture Setup” on page 28).
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Defining Patterns
To select an item for capture, either highlight the category and click the Add>> button, 
or double-click the category, to open a corresponding definition dialog. You can define 
patterns for specific ports by checking or unchecking the Port ID.

Primitive 
Double-click Primitive (available only if you check Exclude Patterns) to open the 
Primitive selection dialog.

Figure 29. SAS: Primitive Dialog
SAS vs. SATA: SATA Dialog has no radio buttons and has different drop-down 
options.

Click the down arrow next to the Primitive drop-down list box, choose a Primitive to 
exclude, and click OK. Repeat for additional Primitives.

Port ID
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Data Pattern 
Double-click Data Pattern to open the Data Pattern definition dialog 

Figure 30. SAS: Data Pattern Dialog
SAS vs. SATA: SATA Dialog shows Port at the top and does not show SSP or STP.

Define the data pattern for capture or exclusion from capture and click OK.

Note: When entering the data pattern in the “Data” section of this screen, if you are reading 
the data pattern from a recorded trace, you must reverse the order of the bytes listed 
for each dword entered. For example, if you want to capture (or exclude) “00 01 02 03” 
(as displayed in the trace), you must enter this pattern as “03 02 01 00”.
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Protocol Errors 
Double-click Protocol Errors to open the Protocol Errors selection dialog.

Figure 31. SAS: Protocol Errors Dialog
SAS vs. SATA: SATA Dialog shows Port and does not show SSP, SMP, or STP radio 
buttons.

Check protocol error(s) to omit or not capture, then click OK.
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STP Frame (SAS only) 
Double-click STP Frame to open the FIS Patterns dialog.

Figure 32. SAS: FIS Patterns Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the Type drop-down list box, choose an FIS type to 
capture or exclude, and click OK. Repeat for additional types.

Available FIS Types
• Register Host to Device
• Register Device to Host
• Set Device Bits
• DMA Activate
• DMA Setup
• BIST
• PIO Setup
• Data
• Vendor
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 Address Frame (SAS only) 
Double-click Address Frame to open the Address Frame Type Pattern dialog.

Figure 33. SAS: Address Frame Type Pattern Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the Address Frame Types list box and choose an 
address frame type.

SMP Frame (SAS only) 
Double-click SMP Frame to open the SMP Frame Pattern dialog.

Figure 34. SAS: SMP Frame Pattern Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SMP Frame Type list box and choose a frame type. 
Assign a specific function to the frame by clicking the down arrow next to the Function 
list box and choose a function.
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SSP Frame (SAS only) 
Double-click SSP Frame to open the SSP Frame Pattern dialog.

Figure 35. SAS: SSP Frame Type Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SSP Frame Type list box and choose an SSP Frame 
type.
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FIS (Frame Information Structure) (SATA only) 
Double-click FIS to open the FIS Type selection dialog.

Figure 36. SATA: FIS Types Dialog
SAS vs. SATA: Not available in SAS.

Click the down arrow next to the Type drop-down list box, choose a FIS type to 
capture, and click OK. Repeat for additional types.

Available FIS Types
• Register Host to Device
• Register Device to Host
• Set Device Bit
• DMA Activate
• DMA Setup
• BIST
• PIO Setup
• Data
• Any Type
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FIS Pattern (SATA only) 
Double-click FIS Pattern to open the FIS Pattern selection dialog.

Figure 37. SATA: FIS Pattern Dialog
SAS vs. SATA: Not available in SAS.

The FIS Pattern dialog opens with the default FIS Type as Register Host to device. 
To choose another available FIS Type, click the down arrow next to the FIS Type list 
box.

Figure 38. SATA: FIS Pattern Dialog Dropdown
SAS vs. SATA: Not available in SAS.

Choose FIS Type and complete the corresponding dialog.
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FIS Types (SAS and SATA)
If you select STP Frame (SAS) or FIS Pattern (SATA) for the Pattern, the FIS Pattern 
window opens. You can select the FIS Type in this window from among the following 
types.

Register Host to Device 

Figure 39. Register Host to Device
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Register Device to Host 

Figure 40. Register Device to Host

Set Device Bits 

Figure 41. Set Device Bits
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DMA Activate

Figure 42. DMA Activate

DMA Setup

Figure 43. DMA Setup
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BIST 

Figure 44. BIST

PIO Setup

Figure 45. PIO Setup
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Data

Figure 46. Data

Vendor
Vendor is for FIS Pattern. 

Figure 47. Vendor
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Trigger Setup
 The Trigger tab in the analysis project dialog allows you to specify when the analyzer 
completes a data capture. Three trigger modes are available: The default 
Don’t care (Snapshot), Manual Trig, and Pattern.

When data capture starts with Don’t care (Snapshot) selected, the analyzer triggers 
on the first data pattern on the bus. 

Starting a data capture with Pattern selected triggers when specific pattern(s) are 
detected in the captured data stream. The following three ways can trigger the 
analyzer with Pattern selected.

• Trigger on any pattern (Any Trigger Mode)
• External Trigger
• Trigger on a sequence of patterns (Sequential Trigger Mode)

Snapshot Mode
To trigger immediately on any pattern, check the Don’t care (Snapshot) button.

Figure 48. Default Trigger Selected

Manual Trigger Mode
In the Manual Trigger mode, the analyzer captures bus traffic continually from when 
you use the Manual Trigger until you click the Stop Hardware button (on the analyzer 
toolbar), which triggers the analyzer. To perform a manual trigger, check the 
Manual Trig button.
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Any Trigger Mode
In Any Trigger mode, the Analyzer triggers whenever any of the patterns selected for 
triggering occurs (an OR condition). The procedure for selecting trigger parameters is 
identical to that for selecting capture parameters. All items selected for triggering 
appear in the Project Tree.

To define patterns for triggering, check the Pattern button in the Trigger dialog.

Figure 49. SAS: Select Patterns for Trigger
The SAS Parameters window displays the following trigger pattern categories:

• Timer
• Timeout
• External Trigger
• Bus Condition
• Symbol
• Primitive
• STP Frame
• ATA Command
• ATAPI
• Address Frame
• SMP Frame
• SSP Frame
• SCSI Command
• Data Pattern
• Protocol Errors
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The SATA Parameters window displays the following trigger pattern categories:
• Timer
• Timeout
• External Trigger
• Bus Condition
• Symbol
• Primitive
• FIS
• FIS Pattern
• ATA Command
• ATA Command Pattern
• ATAPI
• Soft Reset
• Data Pattern
• Protocol Errors

Choosing a Parameter 
Either highlight the category and click the Add>> button, or double-click the category, 
to open a corresponding definition dialog.
To remove an item, highlight it in the Project Tree, then click the <<Remove button.

Triggering on a Timer
Selecting a timer for a trigger in the Any Trigger Mode limits the time that the 
analyzer looks for selected triggering conditions before triggering. The timer activates 
when the Project runs. If none of the selected triggering conditions occurs during the 
timer’s active time, the Analyzer triggers at the end of the time set for the timer.

You can set a timer independently of any other trigger selection, to cause an 
unconditional trigger after a set time.

To set the timer value, double-click Timer in the Pattern window of the 
Capture Project dialog to open the Timer dialog.

Figure 50. Timer Dialog
Check a Time Unit, enter the Timer Value, and click OK.
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Timeout
Selecting Timeout for the pattern opens the Timeout Pattern dialog.

Figure 51. Timeout Dialog
Select a pattern for Start Events or End Events, enter a Timeout value, then select 
Trigger Mode: 

• If End Events occur before timer expires
• If timer expires before End Events

Note: You cannot select a Timeout pattern if you select any other pattern as the trigger 
condition.

External Trigger
You can trigger on an external trigger. To set up the trigger, click the External Trigger 
category.

Figure 52. External Trigger Dialog
You cannot select an External Trigger Setting, so click OK.
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Bus Condition
Double-click Bus Condition in the Pattern window of the Capture Project dialog to 
open the Bus Conditions dialog.

Figure 53. SAS: Bus Conditions Dialog
SAS vs. SATA: SATA Dialog separates the COMINIT and COMRESET check boxes 
and replaces COMWAKE with Host COMWAKE and COMSAS with Device 
COMWAKE. 

Check Conditions on which to trigger, then click OK.

Note: You can define triggering for specific ports by checking or unchecking Port IDs. 
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Symbol
Double-click Symbol in the Pattern window of the Capture Project dialog to open the 
Symbol dialog.

Figure 54. Symbol Dialog
Choose a symbol type by checking either the K Symbol or D Symbol option, then click 
the down arrow in the Symbol dropdown list, choose a symbol to trigger on, and click 
OK. Note that the D Symbol choice does not have a down arrow. 
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Primitive 
Double-click Primitive in the Pattern window of the Capture Project dialog to open the 
Primitive dialog.

Figure 55. SAS: Primitive Dialog
SAS vs. SATA: SATA Dialog has no radio buttons and has different drop-down 
options.

Click the down arrow next to the Primitive dropdown list, scroll the list to choose a 
primitive on which to trigger, and click OK. Note: Check the box to the right of the 
Primitive Type to use the logical NOT.

Figure 56. SAS: Primitive Selection Choices
SAS vs. SATA: SATA Dialog has different choices.
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ATA Command 
Double-click ATA Command in the Pattern window of the Capture Project dialog to 
open the ATA Command Pattern dialog.

Figure 57. SAS: FIS Pattern Dialog
SAS vs. SATA: SATA Dialog has different dropdown options.

Click the down arrow next to the Command dropdown list, scroll the list to choose a 
command to trigger on, and click OK.

A powerful triggering choice is Any Command, which causes the analyzer to trigger 
on any ATA command.
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ATAPI 
Double-click ATAPI in the Pattern window of the Capture Project dialog to open the 
ATAPI Pattern dialog.

Figure 58. SAS: ATAPI Pattern Dialog
SAS vs. SATA: SATA Dialog has different dropdown options.

Click the down arrow next to the CDB dropdown list, scroll the list to choose a CDB 
Type, and click OK.
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Data Pattern 
Double-click Data Pattern in the Pattern window of the Capture Project dialog to open 
the Data Pattern dialog.

Figure 59. SAS: Data Pattern Dialog
SAS vs. SATA: SATA Dialog shows Port at the top and does not show SSP or STP.

Define the data pattern for triggering and click OK.

Note: When entering the data pattern in the “Data” section of this screen, if you are reading 
the data pattern from a recorded trace, you must reverse the order of the bytes listed 
for each dword entered. For example, if you want to trigger on “00 01 02 03” (as 
displayed in the trace), you must enter this dword pattern as “03 02 01 00”.
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Protocol Errors 
Double-click Protocol Errors in the Pattern window of the Capture Project dialog to 
open the Protocol Errors dialog.

Figure 60. SAS: Protocol Errors Dialog
SAS vs. SATA: SATA Dialog shows Port and does not show SSP, SMP, or STP radio 
buttons.

Check the protocol error(s) to trigger on and click OK.
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STP Frame (SAS only) 
Double-click STP Frame in the Pattern window of the Capture Project dialog to open 
the FIS Pattern dialog.

Figure 61. SAS: FIS Pattern Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the FIS type dropdown list, scroll the list to choose an 
FIS type on which to trigger, and click OK.
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Address Frame (SAS only) 
Double-click Address Frame in the Pattern window of the Capture Project dialog to 
open the Address Frame Type Pattern dialog.

Figure 62. SAS: Address Frame Type Pattern Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the Address Frame Type dropdown list, scroll the list to 
choose an address frame type on which to trigger, and click OK.
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SMP Frame (SAS only) 
Double-click SMP Frame in the Pattern window of the Capture Project dialog to open 
the SMP Frame Pattern dialog.

Figure 63. SAS: SMP Frame Pattern Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SMP Frame Types dropdown list, then scroll the list 
to choose an SMP frame type on which to trigger.

Then click the down arrow next to the Function dropdown list, choose a function, and 
click OK.
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SSP Frame (SAS only) 
Double-click SSP Frame in the Pattern window of the Capture Project dialog to open 
the SSP Frame Type dialog.

Figure 64. SAS: SMP Frame Type Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SSP Frame Type dropdown list, scroll the list to 
choose an SSP frame type on which to trigger, and click OK.
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SCSI Command (SAS only) 
Double-click SCSI Command in the Pattern window of the Capture Project dialog to 
open the SCSI Command Pattern dialog.

Figure 65. SAS: SCSI Command Pattern Dialog
SAS vs. SATA: Not available in SATA.

Click the down arrow next to the CDB dropdown list, scroll the list to choose a CDB 
Type, and click OK.
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FIS (Frame Information Structure) (SATA only)
Double-click FIS to open the FIS Type selection dialog.

Figure 66. SATA: FIS Type Dialog
SAS vs. SATA: Not available in SAS.

Click the down arrow next to the Type drop-down list box, choose a FIS type on which 
to trigger, and click OK. Repeat for additional types.

Available FIS Types:
• Register Host to Device
• Register Device to Host
• Set Device Bit
• DMA Activate
• Any Type
• DMA Setup
• BIST
• PIO Setup
• Data 

Note: You cannot trigger on a Vendor FIS.
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FIS Pattern (SATA only)
Double-click FIS Pattern to open the FIS Pattern selection dialog.

Figure 67. SATA: FIS Pattern Dialog
SAS vs. SATA: Not available in SAS.

The FIS Pattern dialog opens with the default FIS Type Register Host to device. 
To choose another available FIS Type, click the down arrow next to the FIS Type list 
box.

Figure 68. SATA: FIS Pattern Dialog Choices
SAS vs. SATA: Not available in SAS.

Choose an FIS Type and complete the corresponding dialog.
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ATA Command Pattern (SATA only)
Double-click ATA Command Pattern to open the ATA Command Pattern selection 
dialog.

Figure 69. SATA: ATA Command Pattern Dialog
SAS vs. SATA: Not available in SAS.

Click the down arrow next to the Command list box, choose an ATA command, and 
click OK.

Soft Reset (SATA only)
Double-click Soft Reset to open the Soft Reset dialog. 

Figure 70. SATA: Soft Reset Dialog
SAS vs. SATA: Not available in SAS.
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Sequential Trigger Mode
In Sequential Trigger mode, triggering occurs whenever the system detects a specific 
sequence of patterns. Defining the triggering patterns sets the sequence order. You 
must define at least two patterns to enable selection of Sequential Trigger mode.

Note: Patterns, such as Primitives and Symbols or Frames, occurring very close together on 
different ports, cause an error in triggering.

To define a triggering sequence, select more than one pattern, then check the 
Define Sequential Trigger Mode check box.

Figure 71. SAS: Select Sequential Trigger Mode
SAS vs. SATA: SATA Dialog has different patterns.

Timer 
The sequential triggering mode offers the option of triggering on a timer or inserting a 
timer in the triggering sequence to delay detection of the next pattern in the sequence. 
To insert a timer in the trigger list, double-click Timer to open the Timer dialog.

Figure 72. Timer Dialog
Enter a Timer Value, choose the Time Unit, and click OK.
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Defining Patterns 
The definition of patterns for the sequential trigger mode is identical to the Any Trigger 
mode, with the following exception: 
In sequential triggering mode, the definition dialogs for the triggering patterns enable 
the setting to count the number of occurrences. This allows you to specify the number 
of times that the pattern must occur before triggering or proceeding in the trigger 
sequence.

Figure 73. Number of Occurrences
Note: The events on each link are counted independently, causing a trigger whenever the 

number of occurrences on any link equals the specified value.

Triggering Order 
As triggering patterns are defined and added, they are displayed in the Project Tree 
sequentially in the order that they were entered under the Trigger category. When the 
project runs, the analyzer detects the occurrence of each pattern in order and triggers 
on the last one.
You can re-order the sequence of triggering patterns. To change the sequence order, 
highlight a trigger pattern and use the Up or Down arrow to move it to a new position.

Figure 74. Triggering Order
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Pre-Trigger
You can set the amount of data to capture before and after the trigger, as a  
percentage of pre-trigger, between 1% and 99%. Position the pre-trigger slider to a 
percentage. This feature allows the evaluation of bus activity leading up to and after 
the triggering event. Figure 75. illustrates the operation of pre-trigger in data memory.

Pre-trigger data is capture of the specified percentage of data prior to the triggering 
event. It cannot be guaranteed and may be 0. This can occur when the triggering 
event occurs before storing the required amount of pre-trigger event data. In such a 
case, the data display shows fewer than the specified data points prior to the 
triggering event.

Figure 75. Pre-Trigger Example, 20% Pre-Trigger



Protocol Analysis

66

Project Settings
To set project options, click the Settings tab.

Figure 76. SAS: Setting Project Options
SAS vs. SATA: For the ALIGN Transmission Period section, SATA Dialog shows 
options 256 and 258, and does not show 2048 or 2049. 
For Speed, SATA Dialog shows H1, D1 to H4, D4 and does not show I1, T1 to I4, T4. 
SATA Dialog does not show MUX Setting button.
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Memory Settings
The Trace Memory Status section has the following fields.

Trigger Position 
Pre-Trigger defaults to 50%, which defines the percentage of data to capture before 
and after the triggering event. You can change this percentage by dragging the slider.
Capture of the specified percentage of the data prior to the triggering event cannot be 
guaranteed and may be 0. This can occur if the triggering event occurs before storing 
the required amount of pre-trigger event data. In such a case, the data display shows 
fewer than the specified data points prior to the triggering event. For more detail, see 
“Pre-Trigger” on page 65.

Memory Size 
To reduce the capture memory size, check Partial Memory and enter a buffer size, or 
check Entire Memory to allow capture for the entire memory, if you want to capture 
the maximum amount of trace data. (Minimum size of memory is 2 GB. Maximum size 
of entire memory is 8 GB.)

Note: In cases where the size of a data packet exceeds the set buffer memory allocation, 
the project runs, but no capture results. In such cases, you must increase the buffer 
memory size to a value greater than the packet size.

Sample File Name 
Click the ellipses next to the Sample File Name text box and choose a file name and 
location for the results of your current project.

Auto Run 
To repeat the current capture and trigger setup automatically, check the Auto Run 
checkbox and enter the number of times in the Number of Run text box. The capture 
and trigger repeat automatically for the specified number of times, and the results are 
saved in consecutively numbered Sample.scs files.



Protocol Analysis

68

Analyzer Settings
The Analyzer Settings section has the following fields.

Primitive Response Timeout 
Primitive Response Timeout specifies the number of DWORDs after a 
Primitive Response.

Disable Scrambling 
If checked, causes the Analyzer to assume that no traffic is scrambled. By default, the 
Analyzer assumes the scrambling state of the devices under test 

Show XXXX value 
Check this option to display XXXX values.

ALIGN Transmission Period (differs for SAS and SATA) 
Choose the ALIGN Transmission Period for SSP and STP by clicking the 
corresponding option button, then open the Protocol Error Mask dialog.

Protocol Error Mask 
Click the Protocol Error Mask button to open the Protocol Error Mask dialog.

Figure 77. Protocol Errors Dialog
Check the Protocol Errors not to display in the sample view.

External Trig Out Setting 
The Analyzer can send a Low or High external signal anytime a trigger occurs. Select 
the External Trig Out Setting: High Active, Low Active, or Toggle from High to Low or 
Low to High once (3.3 V output).
Enter the External TrigOut pulse width.

External Trig In Setting 
An external Low or High input signal can cause triggering. Select the 
External Trig In Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

Choose Port Speed 
The default speed is Autospeed. You can also select the port speed from the  
drop-down list: 1.5 Gbps, 3.0 Gbps, or 6.0 Gbps. It is recommended to specify the 
speed, to reduce the hunt for lock speed.

Note: If a Port ID check box has no check, the analyzer does not capture any patterns for 
that port. The system allocates trace memory for that port to its adjacent port, for 
example: I1, T1 <-> I2, T2 or I3, T3 <-> I4, T4.
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Port Configuration 
Port configuration depends on the application you run. To act as analyzer, select the 
Analyzer port configuration. To activate a Device emulator on a port, select the 
TargetEmulator/DeviceEmulator port configuration. To activate the device emulator 
on a port and run the Analyzer on the same port, select Analyzer/Emulator.

MUX Setting (SAS only) 
Enable Muxing on port combinations.

Figure 78. MUX Setting Dialog Box
If you enable this option on two ports, the data of both ports transfers on one physical 
link, whose speed is twice the speed of each link, and the data of two links multiplexes 
on one physical link. For example, two 3 G ports together make one 6 G port. Note the 
following:

• The muxing check boxes are usable only if two or more emulator channels are 
selected.

• The initiator emulator check box is greyed out if only one emulator channel is 
selected.

Figure 79. Initiator Emulator Check Box and Channel Speeds
• The target emulator check box is not displayed at all until two or more emulator 

channels are selected.

Figure 80. Target Emulator Check Box and Channel Speeds
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Add a Project Note
To enter and save information about the current project, click the Notes tab and enter 
the data about the project. 

Figure 81. Project Notes Tab
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Advanced Mode (User-Defined)
Advanced Mode expands Analysis capability by allowing you to program complex 
triggering and data capture projects.

The Advanced Mode is a state machine with up to 23 different states. You can 
program each state individually to:

• Trigger on a different event or trigger unconditionally.
• Capture Everything, Nothing, or a user-defined pattern.
• Include up to three ELSE IF statements, allowing a jump to any other state based 

on a user definition.
• Use up to three timers, which you can set to a maximum value of 42949 ms. You 

can set a timer in the state or continue the timer set in the previous state.
• Output an external trigger High or Low.

Working in Advanced Mode
To start working in the Advanced Mode, click the Easy, Switch to Advanced Mode 
button in an open Analyzer window.

You can:
• Display the state definition
• Set Output Trigger level
• Select up to three timers
• Define the If condition and up to three Else If conditions
• Set number of occurrences before trigger
• Set captured data
• Set excluded data
• Go to next state
• Add state
• Choose link for Sequencer setup
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Figure 82. SAS: State Programming Dialog
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Figure 83. SATA: State Programming Dialog
SAS vs. SATA: SATA Dialog removes Exclude Idle, Exclude ALIGN, Exclude RRDY, 
and Exclude NOTIFY. 
SATA Dialog replaces Exclude SATA_CONT with Exclude CONT and 
Exclude SATA_SYNC with Exclude SYNC. 
SATA Dialog has Patterns Bus Condition, FIS, FIS Pattern, Data Pattern, and 
Protocol Errors and does not have STP Frame, SMP Frame, STP Frame, or 
Address Frame.
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Figure 84. SAS: Advanced Trigger with multiple branches
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Setting Trigger Conditions
To set the If and Else If trigger condition:

1. Click the Add Pattern button  for a Pattern field and choose a trigger 
condition from the drop-down list. 

Figure 85. SAS: Choosing a Trigger Condition
2. Define each selected pattern in the same way as in Easy Mode, as described 

starting on page 31. To use a timer, define it first.

Note: You can set a timer for any If or Else If condition.

3. Enter a value for the number of occurrences before trigger in the Cont field, 
up to a maximum of 65535 occurrences.

4. Choose a capture option: Everything, Nothing, or Pattern.

5. If you choose Pattern, you can select patterns for inclusion or exclusion. 
Clicking the Pattern option enables a pattern definition dialog.

Figure 86. SAS: Choosing a Pattern
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6. Choose pattern(s) and click the +>> button to add them for capture or exclusion. 
You define each pattern the same way as in Easy mode (see “Defining Patterns” 
on page 31).

7. For an output trigger, click the down arrow in the Ext. Out field and choose an 
output trigger level.

8. To go to another state, click the down arrow in the Go To field and select a state. 
If no other state has been defined, choose New State to add a state.

Multi-Link Triggering
You can set different triggering for each link. To set different trigger conditions for a 
link, check the Multi Sequencer check box and select the link for setup from the Port 
drop-down list.

Figure 87. Multi-Link Triggering Setup

Set Timers
You can set and use up to three timers for triggering. You can set each timer for each 
state or continue from a timer set in the previous state. The timer defined for a 
particular state starts when entering that state. To set timers, click the ellipses in the 
Timer field in each state and define each of the timers in the Set Timers dialog.

Figure 88. Set Timers Dialog
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Useful Key Sequences
The following key sequences are active to assist you in navigating a defined state 
machine:
Ctrl+a Add State
Insert Insert State
Del Delete State
Ctrl+c/Ctrl+Ins Copy
Ctrl+v/Shift+Ins Paste
Up/Down arrow keys Moves selection between states
Page Up/Page Down Page Up and Page Down states
Home Go to first page
End Go to end page

Project Settings
Prior to running the Advanced mode project, click the Settings tab. The options in the 
Settings dialog are the same as for the Easy Mode, described starting on page 66.

Figure 89. SAS: Project Settings Page
SAS vs. SATA: For the ALIGN Transmission Period section, SATA Dialog shows 
options 256 and 258, and does not show 2048 or 2049. 
For Speed, SATA Dialog shows H1, D1 to H4, D4 and does not show I1, T1 to I4, T4. 
SATA Dialog does not show MUX Setting button.

Notes
To include some descriptive information about the project, click the Notes tab and 
enter a brief descriptive note (see “Add a Project Note” on page 70).
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Exercise and Capture
SAS: To perform a capture with SAS Initiator Emulator generated bus traffic, click  
File > New > Protocol Analyzer (Initiator Emulator). 

SATA: To perform a capture with SATA Host Emulator generated bus traffic, click  
File > New > Protocol Analyzer (Host Emulator). 

Program the Initiator Emulator or Host Emulator, then set up a capture, as described 
in “Protocol Analysis” on page 19. 

Programming the Initiator or Host Emulator
SAS: Click the Initiator Emulator tab:.

Figure 90. SAS: Initiator Emulator Program Dialog
SATA: Click the Host Emulator tab: 

Figure 91. SATA: Host Emulator Program Dialog
SAS vs. SATA: SATA Dialog removes the SCSI, Task, and SMP buttons and 
replaces the Initiator Setting tab with the Host Setting tab.
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SAS: You can create an Initiator program using ATA, SCSI, Task, and SMP 
commands; Frames; and/or Events. These commands can execute in a program loop 
or be subject to user-specified conditions.

Figure 92. SAS: Host Emulator Program Dialog
SATA: You can create an Host program using ATA, Frames, and/or Events.

Add Program Lines
To add program lines, enter the number of lines to add in the Insert field, then click a 
command button: ATA, SCSI, TASK, SMP, Frame, or Event.

Adding Initiator or Host Emulator Commands

Adding an ATA Command
Click the Insert ATA Command button, click one of the command categories, and 
choose a command.

Figure 93. ATA Dropdown List

Number of Program Lines to add

Add SCSI Command
Add Task Command

Add SMP Command

Insert Instruction
Delete Program Line

Add ATA Command

Insert Frame
Insert Event
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Adding a User-Defined ATA Command
Click the Insert ATA Command button and choose User Defined. This enters an 
ATA command line with editable fields to define your own custom command.

Figure 94. Insert ATA Command

Adding a SCSI Command (SAS only)
Click the Insert SCSI Command button, click one of the command categories, and 
choose a command.

Figure 95. SAS: SCSI Dropdown List

Adding a User-Defined SCSI Command (SAS only)
Click the Insert SCSI Command button and choose User Defined. This enters an 
SCSI command line with editable fields to define your own custom command.

Figure 96. Insert SCSI Command
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Adding a TASK Command (SAS only)
Click the Insert Task Command button and choose the command to insert.

Figure 97. SAS: TASK Dropdown List

Adding an SMP Command (SAS only)
Click the Insert SMP Command button and choose the command to insert.

Figure 98. SAS: SMP Dropdown List
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Adding a Frame
SAS: Click the Insert Frame button and choose the frame type to insert.

Figure 99. SAS: Frame Dropdown List
Note that SSP and STP frames offer additional options.

SATA: Click the Insert Frame button and choose the frame type to insert. 

Figure 100. SATA: Frame Dropdown List
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Adding an Event
Click the Insert Event button and choose the event to insert.

Figure 101. SAS: Event Dropdown List

Figure 102. SATA: Event Dropdown List
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Inserting Instructions
Instructions are logical program elements that allow the definition of how the 
Initiator Emulator program executes. Using instructions, you can define program 
loops, make conditional jumps, and insert delays and stops.

To insert an instruction, click a command in the Initiator Emulator program where you 
want the instruction inserted, then click the Insert Instruction button, then choose the 
instruction to insert.

Figure 103. Insert Instructions Dropdown List

Start Loop 
Click the command at which to start the loop, and then insert the Loop Start 
instruction.

Figure 104. Start Loop

Loop Count 
Enter the number of times to run the loop in the number text box, or click the down 
arrow on the Count Drop-down combo box and choose Infinite.

End Loop 
Click the command at which to stop the loop, and then insert the Loop End 
instruction.

Figure 105. End Loop

Add a Goto 
To insert an unconditional jump to a previously labeled command, insert a Goto 
instruction. Then click the down arrow on the Drop-down combo box and choose the 
label to designate the destination command.

Figure 106. Goto
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Add an If 
To insert a conditional jump to a previously labeled command, insert an If instruction. 
Choose a specialized condition for the If from the If flyout. 

Figure 107. If
Then click the down arrow on the If Drop-down combo box, choose the condition for 
the jump and then the down arrow on the Goto Drop-down combo box, and choose 
the label to designate the destination of the jump.

Figure 108. If on Payload
For commands with incoming payloads, you can specify patterns for a condition by 
clicking the options button on a payload instruction and defining pattern(s).

Figure 109. Specify Patterns

Add Wait for Any Frame 
Insert this instruction and set an expiration time and a label for the Goto. This 
instruction causes the Initiator program to go to the specified label if any frame occurs 
prior to the expiration time. If the expiration time occurs first, the Initiator program goes 
to the next step.

Figure 110. Wait
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Insert Delay 
To delay program execution, insert a Delay instruction. Enter the delay value 
(in microseconds) in the number text box to define a delay.

Figure 111. Delay

Add Stop 
To define the end of the Initiator Emulator program, insert the Stop Initiator Exerciser 
instruction.

Figure 112. Stop

Add a Label 
Add a label to any command, to use for conditional and unconditional jumps. Click the 
command to label, and insert the Label instruction. You can also insert a label by right-
clicking a command and choosing Add Label.

Figure 113. Label
Labels are automatically labeled as Label# sequentially as they are added. However, 
you can assign them meaningful names such as STOP and START.

Instruction insert 
You can set the instruction to insert before or after a command by setting the insertion 
mode. To set the insertion mode, right-click in the initiator page and choose Insert 
before current position or Insert after current position.

Figure 114. Instruction Insert

Phy Reset Sequence and Identification
The system performs this when required, by default, but you can perform it manually 
or on each run.
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Sample Host Emulator Program (SATA only)
Figure 115. shows a simple completed SATA Host Emulator program.

Figure 115. SATA: Sample Host Emulator Program

Sample Initiator Emulator Program (SAS only)
Figure 116. shows a simple completed SAS Initiator Emulator program.

Figure 116. SAS: Sample Initiator Emulator Program

Data Blocks
For commands requiring data blocks, click the down arrow of the  
Payload Data drop-down combo box and choose from a set of pre-defined data 
blocks. If you need a new data block, select Configuration > Data Block or click 

the  Data Block icon on the tool bar to open a data block definition dialog (see 
“Creating a Data Block” on page 114 for instructions on creating data blocks).

Option button

Option button
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Exercising Specific Addresses
Since more than one device can be active at any given time, you can specify specific 
commands to send to an address. To assign commands to an address: 

1. Click the down arrow on a Target SAS Address block in a completed 
Initiator Emulator program, then choose Find New Device. 

Figure 117. SAS: Find SAS Devices Select
Choosing Find New Device opens the Device Identifier dialog. (The default Find 
option is SAS address) 

Figure 118. SAS: Device Identifier Dialog
SAS vs. SATA: SATA Dialog does not show Find section (All Info and SAS Address). 
SATA Dialog has devices D1 to D4 and does not show T1 to T4. 
SATA Dialog does not show Supported Pages and Subpages.

Find New Device

Cursor



Exercise and Capture

89

2. Click the Find device button to display all active addresses.

Figure 119. SAS: Active SAS Addresses
3. To assign commands to an active address, right-click an address and choose: 

Insert To Cursor assigns all commands up to the cursor to the chosen address. 
Insert: To All assigns all commands to the chosen address.
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Record and Play
This feature allows the selection of a range of commands in a trace and exports them 
to a previously saved *.sac file for execution by the SAS Initiator Emulator or *.stc file 
for execution by the SATA Host Emulator. You can export commands from all 
available samples, between X and Y cursors, or between designated commands.

To perform this action:

1. Run a capture project or open a previously run and saved a captured trace file.

2. Set X and Y cursors to export between cursors.

Figure 120. SAS: Captured Trace Display With Cursors Set
3. Click File and then choose Export to Initiator Emulator or Export to Host 

Emulator. 

Figure 121. SAS: Export to Initiator Emulator
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This displays the Extract Sample File dialog.

Figure 122. Extract Sample File Dialog
4. Click the ellipses next to the Project Name address bar and select an existing 

*.sac or *.stc file.

5. Choose an export range and item, Command, or FIS, then click Export.
6. After the export action completes, open the exported *.sac or *.stc file.

Figure 123. SATA: Host Emulator Program With the Exported Commands
You can run this set of commands immediately, or you can modify it by inserting 
instructions and/or additional commands.
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Error and Command Settings
Each command type allows you to set a variety of command settings and to introduce 
errors. Click the Option button on a command line to display the corresponding 
Protocol Error and Command Settings dialog.

ATA Error and Command Settings

Figure 124. SAS: Protocol Error and Command Settings for ATA Dialog

Figure 125. SATA: Protocol Error and Command Settings for ATA Dialog
Connection Rate 

Select the Connection Rate to allow a higher speed port to communicate with a lower 
speed port: Physical Rate, 1.5 G, 3, or 6.

Trigger Source 
Click the down arrow on the Trigger Source combo box to choose trigger type: 
Immediate, Wait for external trig, or Wait for Analyzer trig.

External Trigger Out 
Click the down arrow on the External Trigger out combo box to choose the external 
trigger level: High, Low, or No change on command execution.
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Retry 
Enter a value for the number of command retries when a command failed in the Retry 
text box.

Store Payload in Buffer 
Check the Store Payload in Buffer check box and enter values for Data Offset and 
Data Length.

Auto Update LBA 
Check the Auto Update LBA check box and check an auto update option button.

Random Error Injection 
Random Error Injection specifies the probability of Error Injection on the command. 
The probability percentage that you select applies to all Error Injection items.

Close Connection Setting 
Checking Close Connection Setting enables the Error Settings button. Click this 
button to display the Close Connection Setting dialog,

Figure 126. Close Connection Dialog
Select the Close Sequence Type from the drop-down list. Selecting 
Delay in sending allows you to specify the delay in sending Done, Close, or Break.

Select the Close Connection Settings from the drop-down lists.

Outgoing Open Error 
Check Outgoing Open Error and then the enabled Error Settings button to display 
the Open Frame Setting dialog.

Figure 127. Open Frame Setting Dialog
Check errors to introduce.

Scroll through the available choices in the Destroy Field of Frame list box and check 
the field to destroy.
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Incoming Open Primitive Response 
Check this box, then click the down arrow next to the Primitive list box and choose a 
response type. Enter a Delay value.

Figure 128. Incoming Open Primitive Response Dialog

Affiliation Setting
Check Clear Affiliation After Command Complete to release device to commands 
from other sources, or check Leave Affiliation State Unchanged to retain control of 
device.

Enable First Burst
Check Enable First Burst to allow first burst.

Task Attribute
Choose Simple, Head of Queue, Ordered, or ACA.
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Outgoing ATA Frame Settings
Before selecting Outgoing Frame Settings, select the Types Of Frames and the Frame 
Number on which to inject an error. Then check Outgoing Frame in the 
Generate Error On area and then the enabled Settings button to display the 
Outgoing Frame Settings dialog.

Figure 129. Outgoing Frame Settings
Frame Type Error 

Check this to introduce a frame type error. 

Remove Frame from sequence 
Check this to remove frame from sequence. 

Delay in sending frame 
Check this to delay sending frame and enter a value for the delay. 

Frame Length Error 
Check Frame Length Error and choose the type of error to introduce. 

Code violation and Disparity error 
Check these and specify DWord offset and number of error DWords. 

Additionally check: 
No WTRM 
Code Violation on SATA primitive 
Disparity error on SATA primitive 
Ignore XRDY/RRDY sequence 
Delay in HOLD response (in sending HOLDA) 

SOF, EOF and CRC errors 
Check these and specify Double or Omit by checking the corresponding option button.
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Insert Primitive 
Check Insert Primitive and then click the Type button to open the Primitive Type 
dialog and select the primitive type. 

Figure 130. Primitive Type Dialog
Click the down arrow on the Primitive combo box, choose a primitive, then click OK.

Fill reserved fields with 
Enter a value for which reserved fields to change, if other than 0.

Field of Frame 
Select Destroy, scroll through the available choices in the Field of Frame list box, and 
choose a field to destroy. Alternatively, select Specify Value to fill the chosen field 
with a pre-defined value.

Insert Frame 
Check Insert Frame, click the down arrow on the Type combo box, and choose the 
frame type.Then choose to insert it before or after an outgoing frame command. Make 
sure that you have clicked More.

Note: In addition to the pre-defined frame types, you can scroll down the list to 
User Defined and enter your own frame data between SOF and EOF.
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Incoming ATA Frame Settings
Before selecting Incoming Frame Settings, select the Types Of Frames and the 
Frame Number on which to inject an error. Then check Incoming Frame in the 
Generate Error On area and then the enabled Settings button to display the 
Incoming Frame Settings dialog.

Figure 131. Incoming Frame Setting Dialog ATA

Handshake Error 
Check Handshake Errors to enable selection of errors and primitives. Check R_ERR 
or select Primitive to send as an incoming frame response. Check No Handshake to 
send no response.

Terminate Receiving Frame 
Check Terminate Receiving Frame, then choose the termination type.

Defer Handshake 
Check the Defer Handshake after check box and enter a value for the time to defer 
the handshake.
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SCSI Error and Command Settings (SAS only)

Figure 132. SAS: Protocol Error and Command Settings for SCSI Dialog

Connection Rate
Select the Connection Rate to allow a higher speed port to communicate with a lower 
speed port: Physical Rate, 1.5 G, 3, or 6.

Trigger Source
Click the down arrow on the Trigger Source combo box, and choose trigger type: 
Immediate, Wait for external trig, or Wait for Analyzer trig.

External Trigger Out
Click the down arrow on the External Trigger out combo box to choose the external 
trigger level: High, Low, or No change on command execution.

Retry
Enter a value for the number of command retries for failed commands in the Retry text 
box.

Random Error Injection
Random Error Injection specifies the probability of Error Injection on the command. 
The probability percentage that you select applies to all Error Injection items.
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Close Connection Setting
Checking Close Connection Settings enables the Error Settings button. Click this 
button to display the Close Connection Setting dialog.

Figure 133. SAS: Close Connection Settings
Select a Close Sequence Type from the drop-down list.

Check Delay in Sending to specify the delay in sending Done, Close, or Break. 

Select Close Connection Settings from the drop-down lists.

Store Payload in Buffer
This option is available for read type commands. Choose and specify Data Offset and 
Data Length.

Auto Update LBA
Check to enable Auto Update of LBA, then specify the update by checking the option.

Outgoing Open Error
Check Outgoing Open Error and then the enabled Error Settings button to display 
the Open Frame Setting dialog.

Figure 134. SAS: Open Frame Settings
Check the errors to introduce.

Scroll through the available choices in the Destroy Field of Frame list box and check 
the destroy field.
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Incoming Open Primitive Response
To set a response to an incoming Open frame, check Incoming Open Frame 
Response, select a Primitive, and enter a value for Delay. 

Figure 135. SAS: Open Primitive Response

Enable First Burst
Check the Enable First Burst box to specify to transfer the first burst data as defined 
by the First Burst Size field in the Advanced Initiator Setting dialog. See Figure 142. 
on page 106.

Task Attribute
Choose a task attribute of Simple, Head of Queue, Ordered, or ACA by checking the 
corresponding option button.
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Outgoing SCSI Frame Settings
Before selecting Outgoing Frame Settings, select the Types Of Frames and the 
Frame Number on which to inject an error. Then check Outgoing Frame in the 
Generate Error On area and then the Settings button to display the 
Outgoing Frame Setting dialog.

Figure 136. SAS: Outgoing Frame Setting Dialog SCSI
Frame Type Error

Check this to introduce a frame type error.

Remove Frame from sequence
Check this to remove frame from sequence.

Delay in sending frame
Check this to delay sending frame and enter a value for the delay.

Frame Length Error
Check Frame Length Error, then choose the type of error to introduce.

Code violation and Disparity error
Check these and specify DWord offset and the number of error DWords.

Don’t check credit
Check this to disable credit checking.

SOF, EOF and CRC errors
Check these and specify Double or Omit by checking the corresponding option button.
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Insert Primitive
Check Insert Primitive, click the Type button to open the Primitive Type dialog, then 
select the primitive type.

Field of Frame
Select Destroy, scroll through the available choices in the Field of Frame list box, and 
choose a field to destroy. Alternatively, you can select Specify Value to fill the chosen 
field with a pre-defined value.

Insert Frame
You can insert a frame before or after the current frame. To insert a frame, check 
Insert Frame, check the option button at which to insert the frame, and choose a 
Frame Type.

Figure 137. SAS: Insert Frame

Incoming SCSI Frame Settings
Before selecting Incoming Frame Settings, select the Types Of Frames and the 
Frame Number on which to inject an error. Then check Incoming Frame in the 
Generate Error On area and then the enabled Settings button to display the 
Incoming Frame Setting dialog.

Figure 138. SAS: Incoming Frame Setting Dialog (SCSI)
Handshake Error

Check Handshake Error and select NAK CRC Error, No Handshake, or Primitive 
and a Primitive Type.

Defer Handshake
Check the Defer Handshake after check box and enter a value for the time to defer 
the handshake.
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Initiator Setting Tab (SAS only)
The Initiator Setting tab allows you to select the Port(s) for generating SAS traffic and 
to specify SAS Address, Data Frame Payload size, Frame Receive Timeout, Logical 
Block size, and ATA Command Execution Time out. 

You can run a Pattern Generator. To run the Pattern generator, check the 
Run Pattern Generator option button and select a Pattern Generator File. You can 
create Pattern Generator Files (see “Appendix A” on page 291).

Figure 139. SAS: Initiator Setting Tab
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Choose Initiator Emulator Port
For each port, select a speed, then click the Speed Negotiation Setting button.

Figure 140. SAS: Speed Negotiation Setting Dialog
Select the port speed settings, all by default.

After you click OK, you can Enable Muxing On.

Pattern Generator
You can select a Pattern Generation file.

Initiator Emulator
You can run an Initiator Emulator while setting:

• Auto stop exerciser when Analyzer stops
• SAS Address
• Data Frame Payload Size
• Frame Receive Timeout
• Logical Block Size
• ATA Command Execution Timeout
• Send NOTIFY ENABLE SPINUP primitive

Check Autostop exerciser when Analyzer Stopped to halt the Initiator Emulator 
when the Analyzer stops. If unchecked, the Exerciser continues to run even after the 
Analyzer stops.
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Queue Settings
Click the Queue Settings button to display the Queue Settings dialog and specify:

• Queue Depth
• NCQ Error Recovery
• Queued/Non-Queued Items Status
• NCQ/Queue Command Timeout.

Figure 141. Queue Setting Dialog
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Advanced Initiator Settings
Click the Advanced button to display additional settable options:
- Align Transmission Period 
- STP Initiator ALIGN Transmission Period 
- Bus Inactivity Time Limit 
- Maximum Connect Time Limit 
- First Burst Size 
- I_T nexus loss time 
- Max Credits in each Connection 
- Delay between getting HOLD and Sending HOLDA.

Figure 142. Advanced Initiator Settings Dialog General Tab
In the Advanced Initiator Setting dialog, choose Automatic action options from 
- ABORT TASK for Failed Commands  
- Multi Command feature.
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OOB Signal Setting Tab
Click the OOB Signal Setting tab in the Advanced Host Setting dialog to specify OOB 
parameters in the enabled editable fields:

Figure 143. OOB Signal Setting Tab

Timeouts Tab
Click the Timeouts tab in the Advanced Host Setting dialog to specify timeouts for 
connection, CREDIT, ACK/NAK, ATA Command, OOB Signal and Identify frame.You 
can also edit the speed negotiation parameters.

Figure 144. Timeouts Tab
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Speed Negotiation Tab
Use the Speed Negotiation tab to inject errors during speed negotiation. 

Figure 145. Speed Negotiation Tab
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Host Setting Tab (SATA)
The Host Emulator Setting dialog allows you to select the Port(s) for exercising, 
choose to use the Host Emulator or Pattern generator and specify Host Emulator 
characteristics. 
Click the Host Setting tab: 

Figure 146. SATA: Host Setting Tab

Choose Host Emulator Port
For each port, select a speed.

Pattern Generator
You can select a Pattern Generation file. To perform a capture with a Pattern 
Generator, enter a path to a pattern generator *.spg file in the File Name dialog. See 
Appendix A for instructions how to create a Pattern Generator file.
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Host Emulator
You can run an Host Emulator while setting:

• Auto stop exerciser when Analyzer stops
• CONT usage
• Delay between getting HOLD to Sending HOLDA
• Data Frame Payload Size
• ATA Command Execution Timeout
• Logical Block Size (for ATAPI)

Check Autostop exerciser when Analyzer Stopped to halt the Host Emulator when 
the Analyzer stops.

Check CONT Usage to enable the specification of Delay between getting HOLD to 
sending HOLDA, Data Frame Payload Size, and ATA Command Execution 
Timeout.

Queue Settings
Click the Queue Settings button to display the Queue Settings dialog and specify:

• Queue Depth
• NCQ Error Recovery
• Queued/Non-Queued Items Status
• NCQ/Queue Command Timeout

Figure 147. SATA: Queue Settings Dialog
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Advanced Host Setting Dialog
Click the Advanced button to display all settable options.

Figure 148. SATA: Advanced Host Setting Dialog General Tab
Settable options are:

• Set Align Transmission Period, Primitive Response Timeout and Await Align 
Timeout.

• Choose ATA Command timeout recovery action by checking the corresponding 
option button.

• Specify Speed Negotiating Failure Option(s) and a Speed Negotiation Failure 
Type.
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OOB Signal Setting Tab
Click the OOB Signal Setting tab in the Advanced Host Setting dialog to specify 
OOB parameters in the enabled editable fields.

Figure 149. SATA: OOB Signal Setting Tab
Asynchronous signal recovery
Set the OOB Retry Interval Time, check the Asynchronous signal recovery option 
check box and enter a value for the time.

Inter-reset Delay Settings
Enter a value for SATA port Selection T1 to specify the inter-reset- assertion delay 
for the first event of the selection sequence and SATA port Selection T2 to specify 
the inter-reset- assertion delay for the second event of the selection sequence.
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Power Management Settings
Click the Power Management Setting tab in the Advanced Host Setting dialog to 
specify the settings in the editable fields.

Figure 150. SATA: Power Management Settings
Set parameters for Host and/or Device initiated power management.

Project Settings
Set project settings in the Project Settings tab (see “Project Settings” on page 66).

Note: When using the Exerciser, channel 2 is not available and is grey.
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Creating a Data Block
You can create the following types of data blocks, for use with data fields:

• Random data pattern
• Custom data pattern specifically for your application
• Counter data pattern
• Walking bit pattern

To create a data block, click the Default Data Block button on the Main 
toolbar, or select Configuration > Data Block to open the Data Block dialog box as 
shown in Figure 151.

Figure 151.  Default Data Block Dialog Box
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To add another data block:
1. Click the New button in the Data Block dialog box.

Figure 152.  New Data Block Dialog Box
2. Choose the number of data columns (up to 16 data cells/row) and the cell length 

(up to 16 bytes/cell). This is a display function only.

3. Click either the Bin, Hex, or Ascii option button to choose a number format.

4. Click either the LSB or MSB option button to choose a bit order.

Naming a Data Block
Each new data block automatically receives a sequential data block number. To 
assign a unique descriptive name to a data block, right-click the data block name to 
open the Data Block Edit menu.

Figure 153.  Data Block Edit
Choose Rename.

Figure 154.  Rename Data Block
Enter a descriptive name in the New Name edit box and click OK.



Exercise and Capture

116

Editing a Data Block
You can enter data in the defined cell structure by these methods:

• Define your own pattern
• Set a counter
• Choose a Random Pattern
• Choose a Walking Bit Pattern

Define Your Own Pattern
To define a pattern:

1. Click Pattern to open the Define Pattern dialog box as shown in Figure 155. 

2. Enter a data pattern in the Data Pattern edit box.

3. Choose the number of times to repeat that pattern, and click OK.

Figure 155. Define Your Own Data Pattern

Address 
The cell address starts at 0 for the first data entry and automatically increments to the 
next available address. You can set it to a previously defined address to modify its 
content or insert additional data.

Insert/Overwrite Data 
To define whether to overwrite data in a previously defined cell or insert new data after 
that cell, toggle the Insert/Overwrite button.

Save 
When you have completed a data block definition, click the Save button to save the 
newly created data block. 
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Counter
To use a counter as data, click the Counter button, enter a Starting Number for the 
counter and the data address to count to, and click OK.

Figure 156. Set Counter as Data

Random Data Pattern
To use a random data pattern, click the Random button, enter the number of times to 
repeat the pattern, and click OK.

Figure 157. Choose a Random Pattern
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Walking Bit Pattern
To use a walking bit pattern, click the Walking Bit button, then choose either a 
walking bit of “0” or “1”, the walk direction, the start position, and the number of times 
to repeat the pattern.

Figure 158. Define a Walking Bit Pattern
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Creating and Editing Data Blocks as Text
You can create and edit data blocks using a text editor such as Windows® Notepad. 
To create a data block in Notepad, launch Notepad. Enter a header consisting of 
[Item1, Item2, Item3, Item4, Item5] where:

Item1 is the name of the Data Block.
Item2 is the size of the Data Block or the number of bytes in the format.
Item3 is the format of the data (HEX, BIN, ASCII).
Item4 is the group of bytes defined (1, 2, 4, 8 or 16).
Item5 is the direction (LSB or MSB).
Then enter the data in space delimited Hex format and save as a *.txt text file.

Load Data
To import Text Editor created data, click the Load button in the data block definition 
dialog to open the Load dialog. Choose a file and click Load. Modify existing data.

Save As
To create a new data block from an existing data block using a text editor, select the 
data block to edit from the Data Block Name list, then click Save As to open the 
Save As dialog.

Assign a name to the new data block text file and click Save.

You can now edit the newly created text file using Notepad or any other text editor, 
then import it into the data block definition, as described above.
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Performance Analysis
Performance analysis is not currently available for Sierra M6-4.
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Target and Device Emulation
You can run the analyzer while device emulation is active to monitor bus traffic.

Pages Tab
SAS: To set up SAS Target Emulation, click File > New > Target Emulator to display 
the target emulator with the Pages tab selected.

Figure 159. SAS: Target Emulation Project Pages Tab
The Target Emulator pages open with default settings for each page. To change 
settings for your application:

1. Select a page in the Supported Pages box and set values for each of the 
enabled (white) Value fields.

2. Enter values for Density Code, Medium Type, and Device Specific Parameter 
for the target emulator.

3. Check SSP or SMP to specify the protocol to support.

4. To reset the pages to the default settings, click the Default Settings button.

5. To use a previously defined Target, click the Import button and choose a 
previously defined Device Identifier *.saf file. 

Note Clicking the Import button on any of the Target Emulation dialogs sets all the 
parameters for the current emulation, including User-Defined Commands.



Target and Device Emulation

122

SATA: To set up a Device Emulation, click File > New > Device Emulator.  
The Device Emulation project opens with the Pages tab selected.

Figure 160. SATA: Device Emulation Project Pages Tab
The Device Emulator pages open with default settings for each page. To change 
settings for your application:

1. Set the Device Type of either ATA or ATAPI

2. Set values for each of the enabled (White) Value fields on the Identify page.

3. To reset the pages to the default settings, click the Default Settings button.

4. To use a previously defined emulation, click the Import button and select an 
emulation.
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Error Injection Tab
Clicking the Error Injection tab opens the General Errors dialog. 

SAS: In addition to specifying general errors, you can also set errors for Identify, 
Connection Management, and SAS Commands by clicking the corresponding icon in 
the Errors window.

Figure 161. SAS: Setting General Errors
SATA: In addition to specifying general errors, you can also set errors for 
ATA Commands and SATA Signature by clicking the corresponding icon in the Errors 
window

Figure 162. SATA: Setting General Errors
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Setting General Errors
Generate Periodic Error

Generate Periodic Error allows you to inject periodic error on Command frame, 
FIS frame, stand alone primitive, and stand alone FIS. Check 
Generate Periodic Error and select the period unit of time, number of IO commands, 
or number of kilobytes transferred, by checking the corresponding option button.

Outgoing FIS Command Error or Outgoing Frame Command Error
SAS: Check Generate Error on outgoing FIS commands, then click the Setting 
button to open the error setting dialog.

Figure 163. SAS: Outgoing FIS of Command Error Setting
SATA: Check Generate Error on outgoing frame commands, then click the Setting 
button to open the error setting dialog

Figure 164. SATA: Outgoing FIS of Command Error Setting
Frame Length Error 

Check Frame Length Error and choose the type of error to introduce.
Code violation and Disparity errors 

Check these and specify the DWord offset and the number of error DWords.
Don’t check credit (SAS only) 

Check this to disable credit checking.
Value of Reserved Fields 

Enter a value.



Target and Device Emulation

125

Ignore XRDY/RRDY sequence (SATA only) 
Check or not.

Delay in HOLD Response (SATA only) 
Check or not.

No WTRM (SATA only) 
Check or not.

SOF, EOF & CRC Errors 
Check any or all and choose the criteria for introduction.

Insert Primitive 
Check Insert Primitive, click the Type button to open the Primitive Type dialog, then 
select the primitive type.

Send Primitive
Check Send stand-alone primitive, click the Type button to open the Primitive Type 
dialog, select the primitive type, and click OK. 

Figure 165. Primitive Type
Click the down arrow on the Primitive list box, choose a primitive, enter a value for the 
number of primitives to send, and click OK.

Reset Link
Check Reset Link after link enable after and enter time value after which to reset 
the link.

Retain Error Injection Counters after Link Reset
If unchecked, after every Link Reset, the Emulator resets its internal 
Command Number/Counters and re-initializes the Error injection core. If checked, the 
Emulator keeps the state.

Generate Link Errors (SAS only)
To introduce link errors, check Non release of link to prevent release of the link even 
if exceeding link connection time, and/or check Buffer starvation and enter a value in 
Number of R_RDY for each connection text box to simulate a busy link.

Send Hard Reset (SAS only)
Check Send [#of] Hard Reset after PHY Reset and specify number of resets to 
send.

Send FIS (SATA only)
Check Send stand-alone FIS, select the FIS Type button, and optionally enter 
User Defined FIS Data. 
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Identify Errors (SAS only)
Click the Identify icon in the Errors window to display the Identify Error Setting dialog.

Figure 166. SAS: Identify Error Setting Dialog

Sending Identify Frame
Check the Send option button, then specify the number of Identify frames to send 
(and a delay, if needed).  
Not to send Identify frames, check the Do not send identify frames option button.

Frame Type Error
Check this to send a Frame Type error.

Frame Length Error
Check Frame Length error and enter the number of DWords in the corresponding 
text box.

SOAF, EOAF and CRC
Check any or all and check the criteria for introduction.

Code violation and Disparity
Check either or both and specify DWord offset and Number of DWords in the 
corresponding text boxes.
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Connection Management (SAS only)
Click the Connection Management icon in the Errors window to display the 
Connection Management Setting dialog.

Figure 167. SAS: Connection Management Setting Dialog

Open Connection Definition

Incoming Frame Settings
1. In the Open Connection dialog, enter a value for the Incoming Open Frame 

Number and the Number of Errors in the corresponding text box.
2. Click the down arrow next to the Primitive Response: drop down list box, 

choose a primitive response, and enter a value for the Delay in Sending 
Response text box.

3. Enter a value for Outgoing Open Frame Number and Number of Errors in the 
corresponding text box. 

Outgoing Frame Settings
Click Outgoing Open Frame Error Settings to display the Open Frame Setting 
dialog. Check the errors to introduce and click OK.

Figure 168. SAS: Open Frame Setting
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Close Connection Definition
1. In the Close Connection dialog, enter a value for the Erroneous Close 

Connection Number and the Number of Errors in the corresponding text box.

2. Click the down arrow next to the Close Sequence Type drop down list box, 
then choose a closing sequence.

3. For a delay in sending, click the Delay in Sending check box, click the down 
arrow on the associated drop down list box, choose what to delay, and enter a 
value for the Delay Time.

Figure 169. SAS: Delay in Sending
4. Click the down arrow on the ClOSE Primitive or DONE Primitive dropdown list 

box in the Close Connection Settings dialog, then choose a Close or Done 
Primitive.

5. Enter a value in the CLOSE/BREAK Primitive Count text box. 
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SAS Commands Errors (SAS only)
Click the SAS Commands icon in the Errors window to display the 
Commands Error Setting dialog

Figure 170. SAS: SAS Commands Error Setting Dialog
1. Click the SSP, SMP or Task option button to display the commands available for 

each of these categories in the Event Selection window.

2. Click a command for which to set an error, check the Generate Error when: 
check box, then enter values for LBA, TAG, or Command number in the 
corresponding text box. 
  
When using Command Number as the Error Injection filter, you can repeat the 
erring-command sets by checking Repeat error.

3. Click the Command fail with check condition check box, click the down arrow 
on the Sense Key drop down list box, choose an error type, and then enter 
values for ASC and ASCQ in the corresponding text boxes.

4. Set up Outgoing and Incoming frame errors.

Note: Once you check the Generate Error On: check box for a command, a red status 
indication appears next to the command, indicating an error condition.

Status
Indication
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Outgoing Frame Settings
Before selecting Outgoing Frame Settings, select the Types Of Frames and the 
Frame Number on which to inject an error. Then check Outgoing Frame in the 
Generate Error On area and then the enabled Settings button to display the 
Outgoing Frame Setting dialog.

Figure 171. Outgoing Frame Setting Dialog 
Frame Type Error

Check this to introduce a frame type error.
Remove Frame from sequence

Check this to remove frame from sequence.
Delay in sending frame

Check this to delay sending frame and enter a value for the delay.
Frame Length Error

Check Frame Length Error and choose the type of error to introduce.
Code Violation and Disparity error

Check these and specify DWord offset and the number of error DWords.
Don’t check credit

Check this to disable credit checking.
SOF, EOF, and CRC errors

Check these and specify Double or Omit by checking the corresponding option button.
Insert Primitive

Check Insert Primitive, click the Type button to open the Primitive Type dialog, select 
the primitive type, and click OK.

Destroy Field of Frame
Make sure to click the More button and then check the field to destroy.
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Insert Frame
Check Insert Frame, click the down arrow on the Type combo box, and choose the 
frame type. Make sure that you have clicked More.

Incoming Frame Settings
Before selecting Incoming Frame Settings, select the Types Of Frames and the 
Frame Number on which to inject an error. Then check Incoming Frame in the 
Generate Error On area and then the enabled Settings button to display the 
Incoming Frame Settings dialog.

Figure 172. Incoming Frame Setting Dialog
Handshake Error

Check Handshake Errors to enable selection of error on handshake. Check NAK, 
CRC, or any other Primitive to send as an incoming frame response. Check 
No Handshake to send no response.

Defer Handshake Errors
Check Defer Handshake and enter a value for the time to defer the handshake.
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ATA Commands Errors (SATA only)
Click the ATA Commands icon in the Errors window to display the 
ATA Commands Error Setting dialog.

Figure 173. SATA: SAS Commands Error Setting Dialog
To set errors for ATA commands:

1. Click a command for which to set an error and then check the Generate Error 
when check box and chose LBA or Command number with a value in the 
corresponding text box.

2. When you choose Command Number, you can use Repeat error for periodic 
series of errors in commands. Set the number of times to repeat the error, by 
entering a value in the Number of Error Commands text box.

Note: Once you check the Generate Error when: check box for a command, a red 
status indication appears next to the command selected indicating an error 
condition.

3. To force the system to send a defined response frame to the host, check the 
Command fail on Response check box and then choose a pre-defined 
response.

4. Repeat for every command for which to set an error.

Status
Indication
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Outgoing Frame Settings
Before selecting Outgoing Frame Settings, select the Types Of Frames and the 
Frame Number on which to inject an error. Then check Outgoing Frame in the 
Generate Error On area and then the enabled Settings button to display the 
Outgoing Frame Setting dialog.

Figure 174. Outgoing Frame Setting Dialog 
Frame Type Error

Check this to introduce a frame type error.

Remove Frame from sequence
Check this to remove frame from sequence.

Delay in sending frame
Check this to delay sending frame and enter a value for the delay.

Additionally check:
• No WTRM
• Code Violation on SATA primitive
• Disparity error on SATA primitive
• Ignore XRDY/RRDY sequence
• Delay in HOLD response (in sending HOLDA)

Frame Length Error
Check Frame Length Error, choose the type of error to introduce and click OK.

Code violation and Disparity error
Check these and specify DWord offset and the number of error DWords.

SOF, EOF and CRC errors
Check these and specify Double or Omit by checking the corresponding option 
button.

Insert Primitive
Check Insert Primitive to enable the Primitive Type dialog, select the primitive type 
and number of primitives, and click OK.
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Destroy Field of Frame
Click the More button to display the Field of Frame area, check Destroy, and check 
the fields to destroy. Alternatively, check Specify Value to choose from a predefined 
list of values.

Set Value of Field
Check Fill Out in the Field of Frame area and enter values for fields.

Insert Frame
Check Insert Frame and then click the down arrow on the Type combo box and 
choose the frame type. Make sure that you have clicked More.

Note: In addition to the pre-defined frame types, you can scroll down the list to 
User Defined and then enter your own frame data between SOF and EOF.
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Incoming Frame Settings
Before selecting Incoming Frame Settings, select the Types Of Frames and the 
Frame Number on which to inject an error. Then check Incoming Frame in the 
Generate Error On area and then the enabled Settings button to display the 
Incoming Frame Settings dialog.

Figure 175. Incoming Frame Setting Dialog 
Handshake Errors

Check Handshake Errors to enable selection of error on handshake. Check NAK, 
CRC, or any other Primitive to send as an incoming frame response. Check 
No Handshake to send no response.

Defer Handshake Errors
Check Defer Handshake and enter a value for the time to defer the handshake.

Primitive
Check Insert Primitive then click the down arrow on the Primitive drop down combo 
box and choose a primitive.

Terminate receiving frame
Check Terminate receiving frame and choose the termination condition.
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SATA Signature (SATA only)
Click the SATA Signature icon in the Errors window to display the 
SATA Signature dialog.

Figure 176. SATA: SATA Signature Dialog
Choose SATA Signature Content

Choose either the pre-defined Standard or SATA. Alternatively, you can define your 
own signature by checking the User Defined option button and then entering values 
in the enabled fields.

Specify when to send Signature
You can choose from Don’t Send Signature, Send Signature once and declare 
device is ready with BSY=0 and DRDY=1, or Send Signature twice, first with BSY=1 
and DRDY=0 and second with BSY=0 and DRDY=1, by checking the corresponding 
option button.

Note If you choose Send Signature twice, first with BSY=1 and DRDY=0 and second with 
BSY=0 and DRDY=1, the system enables the Hardware initialization delay text box, 
allowing you to set the hardware initialization delay.
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SATA Signature Errors
You can define errors to introduce when sending a SATA Signature. To define the 
errors, click the Error Setting button to open the SATA Signature Error Setting dialog.

Figure 177. SATA: SATA Signature Error Setting
Frame Length Error

Choose the Frame Length Error type to introduce.

SOF, EOF and CRC Errors
Check any or all and check the criteria for introduction.

Code Violation and Disparity errors
Check and specify DWord offset and Number of DWord errors for Disparity error.

Additional Settings
Set and check:

• Value for Reserved fields
• Ignore XRDY/RRDY Sequence
• Delay in HOLD Response
• No WTRM

Insert Primitive
Check Insert Primitive, click the down arrow on the Primitive list box, choose a 
primitive type and enter a value for the Number of Primitive.



Target and Device Emulation

138

User-Defined Commands Tab
To create command(s) specifically for your application, click the 
User Defined Commands tab to display the command definition dialog.

Figure 178. SAS: Command Definition Dialog
To define a command:

1. Enter an Operation Code and a Name in the corresponding text boxes.

2. Click the down arrow on the Type combo box and choose a command type.

3. For command types requiring configuration data, click the down arrow on the 
enabled Config data: combo box and choose appropriate configuration data.

4. Enter the CDB length: 6, 10, 12, or 16.

5. When done, click the New button.

6. The defined command appears in the command name window.

7. To make changes to a previously defined command, highlight the command, 
make the changes, and click Apply. 

Note: After creation, the User-Defined commands appear in the Event Selection dialog.



Target and Device Emulation

139

Target Emulator Settings (SAS)
Click the Settings tab to display the Target Emulator Settings dialog.

Figure 179. SAS: Target Emulator Settings Dialog
The Settings page opens with a default set of values, which you can modify. To return 
to these values, click the Default Settings button.

Define the Target
Enter a SAS Address, Data Frame Payload Size, Logical Block Size, Linked 
Command Expired Time, and ALIGN Transmission Period in the corresponding 
text box.

Media Settings
Enter a value for Average Access Time to simulate Seek/Access time delay of a real 
device. 

Enter a Number of Writable Areas. Define a Start and an End Address, click the 
down arrow under the Area Type, and choose Normal Writable, Circular Writable, 
or Non-Writable. 

Choose Target Emulator Port
Click a port option button, then click the Speed Negotiation Setting button (see 
“Speed Negotiation Tab” on page 108). Select the port speed settings, all by default.
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Ports Configuration
Click the Ports Configuration button to display the Ports Configuration dialog.

Figure 180. SAS: Ports Configuration Dialog
Device Activation

Enter a number of times in the Activate Device field. Enter a Period of Activation.

You can Activate emulator with old settings.

Advanced Settings
Click the Advanced Button to display additional setting options. The dialog opens 
displaying the OOB Signal Setting tab.

OOB Signal Setting
Edit the default values displayed in the white editable fields.

Figure 181. OOB Signal Setting Dialog
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Set Timeouts
Click the Timeouts tab to display the Timeouts setting dialog.

Figure 182. Timeout Setting Dialog
Edit the default values displayed in the white editable fields and click OK.

Set Speed Negotiating error
Click the Speed Negotiation tab to display the Speed Negotiation dialog.

Figure 183. Speed Negotiating Error Setting Dialog
Check a Speed Negotiation Error check box and choose a failure type by checking a 
corresponding option button. Additionally, you can choose the 
Synchronization failure option. 
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Notes Tab
Click the Notes tab and enter a Project Name and a brief description of the 
Target Emulation project (see “Add a Project Note” on page 70).

Run Target Emulation

Click the Activate Device button or select Project Setup > Active Device 
to start emulation.

Note: You can run the analyzer while device emulation is active to monitor bus traffic.
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Device Emulator Settings (SATA only)
Click the Settings tab to display the Device Emulator Settings dialog.

The Settings tab opens with a default set of values, which you can modify. To return to 
these values, click the Default Settings button.

Figure 184. SATA: Device Emulator Settings
PHY/Link layer settings

Enter values for Align Transmission Period, Primitive Response Timeout, and 
Standby Timeout, Device send Align Time and Delay between getting HOLD to 
Sending HOLDA and specify a delay. Check CONT usage.

Media Settings
Enter a value for Average Access time to simulate Seek/Access time delay of a real 
device.

Enter a Number of Areas. Define a Start and an End Address, click the down arrow 
under the Area Type and choose Normal Writable, Circular Writable, or Non 
Writable.

Payload Size
Enter a value for Data Frame Payload Size in the General area.

Choose Target Emulator Port
Click a port option button and click the down arrow next to the Speed list box and 
choose a port speed. Use the Speed Negotiation Setting button to open the dialog 
(see “Speed Negotiation Tab” on page 108).

Note: If you have made some changes to a defined emulation and want to return to the 
original definition, check the Activate the emulator with old settings.

Ports Configuration
Click the Ports Configuration button to display the Ports Configuration dialog (see 
“Ports Configuration” on page 140).
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Activation
Enter number of times and period of activation.

Advanced Options
Click the Advanced button to display the OOB Signal Setting, Power Management 
setting, Speed Negotiation, NCQ Command setting and Miscellaneous additional 
setting dialogs.

OOB Signal Setting
Edit the default values displayed in the white editable fields.

Figure 185. OOB Signal Setting Dialog
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Speed Negotiation
Click the Speed Negotiation tab to display the Speed Negotiation dialog. Specify 
Speed Negotiating Failure Option(s) and a Speed Negotiation Failure Type

Figure 186. Speed Negotiation Dialog
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Power Management Settings Tab

Figure 187. Power Management
1. In the Host Initialized Power Management area, choose whether to support 

the report in the Identify page.

2. Specify the response type for PMREQ_P and PMREQ_S, the delay, and 
Minimum Number of Response Primitives.

3. In the Device Initiated Power Management area choose whether to support 
the report in the Identify page.

4. Define start event by choosing Standby timer expires, STANDBY command 
executes, or Link layer remains in IDLE state more than [XXX] ms.

5. Specify time for Abandon request and Wake up after and enter the Standby 
timer interval.
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NCQ Command Settings Tab

Figure 188. NCQ Commands
1. To enable NCQ commands, check Support NCQ and specify Queue depth.

2. Optionally check Allow multiple command completion and enter values for 
Max time before sending SDP and Max number of command completions 
reported by one SDB.
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Miscellaneous Features Tab

Figure 189. Miscellaneous Features
1. To enable Asynchronous notification, check the Support Asynchronous 

notification feature and specify the Asynchronous notification interval and the 
Maximum number of transmitted Asynchronous notifications.

2. To send a BIST frame, check Send BIST frame and enter a value for the Delay 
before sending BIST FIS.

3. Choose BIST flag options.

Project Note
Click the Notes tab and enter a Project Name and a brief description of the Device 
Emulation project (see “Add a Project Note” on page 70).

Run Device Emulation

Click the Activate Device button to start emulation.

Note: You can run the analyzer while device emulation is active to monitor bus traffic.
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Display Manipulation
Viewer Display

After data is captured (Recorded), the Viewer displays a sample file (.scs for SAS and 
.sts for SATA) in Packet View: 

Figure  190  SAS: Packet View of .scs Sample File

Figure  191  SATA: Packet View of .sts Sample File



Display Manipulation

150

You can configure the data viewer display. Toolbars are available for quick access to 
data viewer display features. 

You can display the same data in:

• Column view, with transactions grouped for each active port

• Text view, with transactions grouped for each active port

• Spreadsheet view

• Histogram view

Note: You can change the view type when opening a sample by changing the default 
workspace or by saving options in the Software Setting dialog.

Switching Views
To display the capture in any other available view, select from the View menu or from 
the View Type toolbar. 

Figure 192.  View Type Toolbar

After you select a view, it appears in a separate window. To increase the new window 

display size, select View > Packet View or click the  Show/Hide Packet 
View button to hide the Packet View.

When scrolling through a window display using the scroll bar, the displays in the other 
windows also scroll.

To rearrange the tiling, select the Window menu and choose Cascade, Tile Vertical, 
or Tile Horizontal.

Compare Payloads
Show/Hide Histogram View

Show Hide Field List View
Show/Hide Statistical Report View

Show/Hide Packet View

Show/Hide Text View
Show/Hide Spreadsheet View

Show/Hide Column View
Show/Hide Waveform View
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Text View
Text View displays the captured data interpreted as transaction frames, grouped in 
columns by port.

To display Text View, select View > Text View or click the  button on the 
View Type toolbar.

Figure 193.  SAS: Text View
.

Figure 194.  SATA: Text View



Display Manipulation

152

Column View
Column View displays the captured data grouped in columns by port. Each row shows 
captured DWORDs on different ports related to the timestamp. It also shows different 
speed (1.5G, 3G, 6G) DWORDs. Different DWORD cell height shows the duration of 
the DWORD.

To display Column View of the current capture, click View > Column View or click 

the  button on the View Type toolbar.

Figure 195.  SAS: Column View

Figure 196.  SATA: Column View

Resize Columns
You can resize the columns in Column View by clicking in the column boundary and 
dragging the boundary to a new position.

Rearrange Columns
You can rearrange columns by left-clicking in the column title and then dragging the 

drag-and-drop icon to a new position.
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Customize Display

Rename Port
You can rename each port for easy identification. To rename a port, right-click the 
port ID in Text View or Column View. 

Figure 197.  Rename Port
Choose Rename title of port to open the Rename Title of Port dialog

Figure 198.  Rename Title of Port

Show/Hide Port
You can simplify the viewer display by hiding the captures of ports. All active ports are 
highlighted on the Show/Hide Ports toolbar. Click a port button to hide the capture for 
that port.

Figure  199  SAS: Show/Hide Ports Toolbar
.

Figure  200  SATA: Show/Hide Ports Toolbar
You can also show or hide a port by right-clicking a Port ID in Text View or 
Column View and choosing Show or Hide (see Figure 197.)
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Show/Hide Field
You can simplify the Viewer display by hiding some fields. You can hide the Duration, 
Relative Time, External Signals, and Packet number fields by right-clicking the 
corresponding field title and choosing Hide Field.

Figure  201  Hide Field
To restore a field to the display, right-click a Port ID field and choose the hidden field 
to restore. 

Figure  202  Show Field
Note: Only the fields previously hidden appear in the restore list.

Related Frames
Right-click a Command frame for an SSP frame, or Register Device to Host for an 
STP frame, to open a short-cut menu, then choose Goto Response to jump to the 
corresponding Response frame in the viewer.

Figure  203  Goto Response
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Similarly, right-click a Response frame for an SSP Frame, or Register Device to 
Host for an STP frame, to open a short-cut menu, then choose Goto Command to 
jump to the corresponding Command frame in the viewer. 

Figure  204  Goto Command

Byte Order
You can change the byte order in fields marked by an arrow and other fields. 

Right-click in the field, select Byte Order, and choose the ordering.

Figure  205  Byte Order
Note: A blue arrow in the byte order field indicates that it has been changed.
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Choose Data Format
You can display data values either in hexadecimal (default) or binary. To choose data 
format, right-click the mouse over a data field, and choose Format and the format.

Figure  206  Format

Show All Data
To display all captured data, click the data expand toggle arrow in a data field, to 
examine the data in detail.

Figure  207  Show All Data
You can expand or collapse all data fields globally. To expand all data fields,  
right-click the mouse in a data field and choose Expand All.

Figure  208  Expand All
To collapse all fields, right-click the mouse in a data field and choose Collapse All.

Data expand toggle
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Field List View
Whenever an additional view (such as Text View) displays, you can display a 
Field List View, which displays field information in a list format.

To open a Field List View of the current capture, select View > Field List View or click 

the  button on the View Type toolbar.

Figure  209  Field List View
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Spreadsheet View
Spreadsheet View displays all of the Packet View fields in a time sequential 
spreadsheet format.

To display the Spreadsheet View of the current capture, click 

View > Spreadsheet View or click the  button on the View Type toolbar.

Figure 210.  SAS: Spreadsheet View

Figure 211.  SATA: Spreadsheet View
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Histogram View
The Histogram View displays a histogram of frame-type transfers.

To display the Histogram View of the current capture, click View > Histogram View or 

click the  button on the View Type toolbar.

Figure 212.  Histogram View
Hide Frames

You can customize the histogram by including only frame types that you want.

To choose frame types to include in the display, click the down arrow on the Frame 
button on the Histogram toolbar and check frame types: 

Figure 213.  SAS: Histogram Frames

Figure 214.  SAS: Histogram Frames
Hide Error Frames

Frames with errors are displayed in red. To hide error frames from the histogram, click 

the  button.
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User Defined
You can define additional items for inclusion in the Histogram by clicking the 

button to open the User Defined dialog.

Figure 215.  SAS: Histogram User Defined Dialog
You can include Primitive and/or Outside Connections frames.

Primitives
To include Primitives, check the Primitive check box, click the down arrow on the 
Primitive list box, and choose a Primitive. 

Figure 216.  SAS: Choosing a Primitive
.

Figure 217.  SATA: Choosing a Primitive
Check a Connection Type option radio button, if available, and click OK.

Zoom
You can Zoom from x1 to x256.
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Waveform Display
You can enable a waveform display for all active ports, and perform timing 
measurements, by positioning timing cursors within the waveform display.

Select View > Wave Form View or click the Show/Hide Waveform button 
on the View Type toolbar to enable the waveform display.

The Compact View shows the OOB Sequence with speed negotiation. 

Figure  218  SAS: Waveform View

Figure  219  SATA: Waveform View

Making a timing Measurement
Timing measurements are made with two timing cursors T1 and T2. Click the 
left mouse button in the gray bar on the top of the waveform display at a point for the 
T1 cursor, and the right mouse button at a point for the T2 cursor. The time difference 
between the cursors is on a line connecting the two cursors.

Figure  220  SATA: Timing Cursors Enabled
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Expanded Waveform View
To see a 10x time scale expansion of the waveform, uncheck the Compact View 
checkbox in the Waveform View window. The OOB Sequence has speed negotiation 
(Hardware version 4 or later). 

Figure  221  SATA: Expanded Waveform View
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Data View

To display data payloads, select View > Data View or click the  
Show/Hide Compare 2 Data Payloads button on the View Type toolbar.

Compare Two Data Payloads
To compare two data payloads, select two different payload packets, one as 
reference. Right-click a payload field in Packet View or a related frame in Text View or 
Spreadsheet View to display a menu, then select Set As Reference Data Payload. 

Figure  222  Set As Reference Data Payload
Select a second data payload and select Set As Second Data Payload.

Then select View > Compare payload views or click the Show/Hide 
Compare 2 Data Payloads button on the View Type toolbar.

Figure  223  Compare Data Payloads
Note: If you select reference and second data payloads, the Compare Payloads view is 

active.
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Port Status
You can get an overview of the active ports by clicking the Port Status button at the 
bottom right of the application window.

The Port Status displays the Port, Speed, and Analyzer.

In addition to displaying OOB, Link, Frame, and Error, a display showing the 
% buffer full opens when a trigger occurs.

Figure  224  Port Status Window and Capturing Time
1. Pre-trig capturing (trig is 50%) 
2. Trig point (shown by red bar; 36% pre trig was captured) 
3. Post-trig capturing (50% post-trig was captured and capturing has stopped)

Note: If sample capture occurs with more than one unit active, additional Port Status 
windows display.
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Toolbars
Enabling Tool Bars

To customize the Viewer Display workspace, you can enable and reposition the 
available toolbars. To display or hide toolbars, select View > Toolbar, then check or 
uncheck toolbars.

Toolbars are:
• Main
• Viewer
• Cursor Position
• Layers
• Decode
• Channels (Unit 1, Unit2, and so on)
• Viewer Setting
• View Type

Once enabled, the toolbars can dock at the Viewer Display window or float on the 
windows desktop.

Main Toolbar
See “SAS Software Menus and Toolbar” on page 22.

View Type Toolbar
See “Switching Views” on page 150.
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Viewer Toolbar
The Viewer toolbar allows searching, filtering, collapsing/expanding, and data 
reporting. 

.

The Search button opens the search dialog (see “Search” on page 187).

The Filtering Setup button opens the Filter dialog (see “Filtering” on page 172) 
and allows you to specify the criteria for filtering the result.

The Enable Disable Filtering button toggles the result between a filtered and 
unfiltered view (see “Filtering” on page 172).

The Filter Idle button toggles the display to show/hide idle packets (see 
“Filtering” on page 172).

The Expand/Collapse all Layers button expands or collapses Transport and 
Application layers to simplify results display.

The down arrow on the Go To button allows location of cursors or specific 
packets: Trigger Position, X Position, Y Position, Packet Number, Timestamp, 
Bookmark, Begin, and End.

The Data Report button displays the data report.
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The SCSI Spec Assignment button displays the SCSI Spec Assignment dialog 
for SAS 

It displays the ATAPI Assignment dialog for SATA.
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Viewer Setting Toolbar
The Viewer Setting toolbar allows wrapping, zooming, and configuration

 

Cursor Position Status Bar
To display the cursor position status bar, select Toolbar > Cursor Position.

Figure 225.  Cursor Position Toolbar
See “Using the Cursors and Bookmarks” on page 183.

The Full Screen button on the Viewer Setting Toolbar increases the data display 
area to the full screen.

The Zoom In button on the Viewer Setting Toolbar magnifies the data display 
area on the screen. Clicking this button in Column or Text View increases 
column width only.

The Zoom Out button on the Viewer Setting Toolbar scales the data display area 
to display more data lines on the screen. Clicking this button in Column or Text 
View decreases column width only.

The Normal Zoom button on the Viewer Setting Toolbar resets the zoom to 
default normal on the screen. Clicking this button in Column or Text View resets 
column width only.

The Wrap Packets button on the Viewer Toolbar wraps the packet data in the 
display to eliminate the need for horizontal scrolling.

The View Setting button on the Viewer Setting Toolbar opens the 
Sample Viewer Configuration dialog (see “Display Configuration” on page 192).
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Layers Toolbar (SAS)
The Layers toolbar shows or hides packet types. 

 

.

The Show/Hide Link Packet button displays/hides the Link layer.

The Show/Hide Transport Packet button on the Layers Toolbar displays/hides 
the Transport layer and below. 

The Show/Hide All Commands Packet button shows/hides the Command layer 
and all layers below: SCSI Cmd and Task Mng, SMP Cmd, and ATA Cmd.

The Order/Reorder button toggles the time order of packets.

The Pack/Unpack Repeated Primitives toggles packing repeated primitives in 
one port.

Click the down arrow on the Show/Hide All Commands Packet button
to choose command types to show/hide.
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Layers Toolbar (SATA)
The Layers toolbar shows or hides packet types.

The Show/Hide Physical Packet button toggles the display of physical layer 
packets.

The Show/Hide FIS packet button toggles the display of FIS layer packets. 
When “OFF”, the FIS layer and its links are hidden.

The Show/Hide CMD packet button toggles the display of the CMD packets. 
When “ON”, only the command layer displays.

The Show/Hide Command Queue button displays queued commands.

The Order/Reorder toggles the time order of packets.
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Decode Toolbar
The Decode Toolbar controls encoding and scrambling features.

To view corresponding Unscrambled and Scrambled payload data values 
instantaneously, position the mouse pointer over a data field. 

Figure  226  Payload Data Display

The 10B button displays the payload data as 10-bit encoded data.

The 8B button displays the payload as 8-bit scrambled or unscrambled data, 
depending on the Scrambled setting.

The SC button selects scramble/unscramble for the 8-bit payload data.

The Symbol Notation button decodes the 8-bit or 10-bit encoded data in 
Column View.

The Show Data button displays the payload data values in Column View.

Running Disparity indication
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Filtering
The Filtering menu and options allow you to modify data in the sample viewer display 
to exclude packets with a set of user-defined patterns and show the results in all 
views.

To set up filtering, you must have a viewer display open.

The Filtering menu has the options:

• Enable Filtering (see “Enable Filter” on page 182)
• Filtering (see “Filter Setup” on page 172)
• Link Layer (SAS)
• Transport Layer (SAS)
• Application Layer (SAS)
• Physical Layer (SATA)
• FIS Layer (SATA)
• Command Layer (SATA)
• Filter Idles (see “Filter Idle” on page 182)

Filter Setup

To display the Filter setup dialog, click the  Filter button on the Viewer 
toolbar or select Filtering > Filtering. 

Figure  227  SAS: Filter Setup Dialog
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Figure  228  SATA: Filter Setup Dialog
You can select or deselect each of the items shown in the Filter Options window for 
filtering, by checking or unchecking a corresponding check box. Items not in the 
current sample are in shade.

Note 1 If you select a group, that also selects all child items. 

Note 2 Only packets captured at run time are available for selection for filtering.

Filter Type
You can choose to show or hide the Filter Type items by checking the Show or Hide 
option button.

Filtering Direction
You can select items for filtering in a single direction or both directions by checking the 
corresponding Port. By default, all ports are enabled. Uncheck the port check boxes 
for ports not to include in the filter.

Filter Idle
Depending on the Filter Type (Hide/Show), Idle packets in the Sample Viewer are 
shown or hidden.

Save Filter Setup
After you have set up a Filter configuration, you can save it as an SAS Filter file (*sfl) 
or SATA Filter file (*.tfl) by clicking Save. You can then use it on a different capture by 
clicking Load in the Filter dialog.

Filter Logic
After you have set up Filter options, you can set filter logic to And Related Items to 
apply “AND” logic on related selected options (for example, SCSI commands and SAS 
Addresses) or OR to apply “OR” logic on all selected options.
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Multilevel Filtering in SAS
You can set up a filter in a sequential steps by Multi level filtering. In each level, you 
can select specific items to “AND” to the previous level. The results of all levels show 
in views.

Figure  229  First Level of Multilevel Filtering
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.

Figure  230  Second Level of Multilevel Filtering
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.

Figure  231  Third Level of Multilevel Filtering

Filter descend packets by ascend packet
You can apply a filter on a descend packet if you check the Filter descend packet if 
ascend packet is filtered option. If you uncheck this option, the software only filters 
the filtered packet. For example, if this option is checked and any SCSI command is 
selected, all transport and link packets of this command are filtered,. If you unchecked 
this option, only selected SCSI commands are filtered.
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Selectable Filter Options for SAS
The SAS Filter Options are:

• Bus Condition
• Primitive
• Incomplete Frames
• Address Frames
• SSP Frames
• SMP Frames
• STP Frames
• SCSI Commands
• Task Management Functions
• ATA Commands
• SCSI Command Status (see “Filter Check Condition” below)
• Source SAS Address
• Destination SAS Address
• Pair SAS Address
• Protocol Error
• STP Port
• Tag (see “Filter by Tag Number” below)
• ATAPI SCSI Command
• Miscellaneous (see “Miscellaneous” below)

Bus Condition
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Bus Conditions in the Sample Viewer.

Incomplete Frames
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
Incomplete Frames in the Sample Viewer. 

ATA Command
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured ATA commands in the Sample Viewer.

Protocol Error
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured packets with the specified Protocol Errors in the Sample Viewer.

ATAPI SCSI Command
When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
ATAPI SCSI commands.
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Filter Check Condition
Checking the SCSI Command Status check box enables Check Condition for 
filtering.

Figure 232.  SAS: Filter Check Condition

Filter by Tag Number
Checking the Tag check box displays tags available for filtering. Check the 
corresponding check boxes for tags to filter.

Figure 233.  SAS: Filter by Tag Number
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Filter Miscellaneous
When you choose Miscellaneous, an additional dialog displays, allowing you to 
specify the filtering of State Range and/or External Signal In

Figure 234.  Filter State and/or External Signals
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Use Pair SAS Addresses
You can use all available pair SAS addresses (Source -> Destination) instead of using 
SAS source and destination addresses. To enable the pair SAS address filter option, 
check Use Pair SAS Addresses check box in the Filter dialog.

Figure  235  SAS: SAS Address Filtering before and after Using Pair 
SAS Addresses

Note: If you enable pair SAS addresses, the source/destination SAS addresses options are 
disabled and filtering on them is ignored at filtering time. If you disable pair 
SAS addresses, the pair SAS address option is disabled and filtering on it is ignored 
at filtering time.
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Selectable Filter Options for SATA
The SATA filter options are:

• Bus Condition
• Incomplete Frames
• FIS
• ATA Command
• Protocol Error
• Port
• ATAPI SCSI Command
• Miscellaneous
• Filter Idle

Bus Condition
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Bus Conditions in the Sample Viewer. 

Incomplete Frames
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
Incomplete Frames in the Sample Viewer.  

FIS
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured FIS items in the Sample Viewer.  

ATA Command
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured ATA commands in the Sample Viewer. 

Protocol Error
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured packets with the specified Protocol Errors in the Sample Viewer. 

Port
When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
packet traffic for the selected port. 

ATAPI SCSI Command
When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
ATAPI SCSI commands. 

Miscellaneous
When you choose Miscellaneous, an additional dialog displays, allowing you to 
specify the filtering of State Range and/or External Signal In (see “Filter 
Miscellaneous” on page 179).
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Enable Filter

Select Filtering > Enable Filtering or click the  Filter Enable button on the 
display menu bar to toggle between Filtered and Unfiltered display.

Filter Idle
Depending on the Filter Type (Hide/Show), Idle packets in the Sample Viewer are 
shown or hidden.

You can quickly filter idles by clicking the  Filter Idle button. This button 
toggles between Show and Hide items.
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Using the Cursors and Bookmarks
Cursors

The data viewer display incorporates three cursors labeled X, Y, and T. All cursors are 
initially overlaid and positioned at location 0, which is the trigger position of the 
display. The Trigger, or T, cursor is the measurement reference and is always at 
location 0 in the display.

Positioning the X Cursor
To position the X-Cursor within the viewer data display, click the left mouse button in 
the gray bar on the left side of the sample viewer next to the line in which to place the 
cursor. 

Positioning the Y Cursor
To position the Y-cursor within the viewer data display, click the right mouse button in 
the gray bar on the left side of the sample viewer next to the line in which to place the 
cursor. 

Note: You can also left-click to set the X-cursor and right-click to set the Y cursor in the 
Frame and Column View by clicking in the narrow strip on the very left side of a cell. 
Similarly, you can set the cursors in the Waveform View by left and right clicking at the 
beginning of a waveform.

Time
Time differences between the cursors are displayed in the Cursor Position toolbar. To 
display the cursor position toolbar, select Toolbar from the view menu and choose 
Cursor Position.

Figure 236.  Cursor Position Toolbar

Locate Cursors
To quickly locate any cursor within the data viewer display, click the Go To button and 
choose the cursor to locate. You can also locate a cursor by selecting Go To from the 
Edit menu and choosing the cursor to locate. 

Figure 237.  Locate Cursor
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Go to Time Stamp
To locate a timestamp, click the Go To button and choose Timestamp.

Figure 238.  Time Stamp
Enter a time stamp value in the Go To Timestamp dialog and click OK. 

Figure 239.  Go to Time Stamp

Bookmarks
Bookmarks are a convenient way to mark a point in the data viewer display by name, 
so that you can rapidly return to that point. To create a bookmark, right-click the 
mouse in the data viewer area on a packet in which to place the bookmark.

Figure 240.  Bookmark
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Click Bookmark from the fly out menu to open the Bookmark Comment Dialog.

Figure 241.  Bookmark Dialog
Enter a description for the bookmark and click the Add button. Repeat for additional 
bookmarks.

Note: Column View has a different bookmark mechanism than other views, and you can set 
a bookmark on each DWORD in the view.

Finding a Bookmark
To find a bookmark in the data viewer display, right-click the mouse in the sample 
viewer and select Bookmark.

Figure  242  Go To Bookmark Dialog Box
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Highlight the bookmark to which to go, then click the Go To button, or  
double-click the selection.

Figure  243  Bookmark Found Example in Data Viewer Display

Bookmark Description
To get a quick description of a displayed bookmark, position the tool tip over a 
bookmark. The name and description of the bookmark display.

Set Time Stamp Origin
Right-click in the sample viewer to open the fly out menu:

Figure  244  Bookmark Found Example in Data Viewer Display
Highlight Set Time Stamp Origin and choose either Absolute, Trigger, Current 
Position, or Based on system time.
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Search
The Search menu and toolbar options permit you to examine any data capture file to 
quickly locate the packet or data pattern. 

To perform an initial search, select Edit > Search or click the  Search button 
to open the Search setup dialog (Figure 245).

Note: Only items captured in the sample file are enabled for search. 

Figure  245  SAS: Search Data Pattern
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Figure  246  Search Parameter Definition Dialog
You can continue to search the output file using Next Search (F3) or Previous 
Search (F4) for the same pattern, until you redefine the data capture search 
parameters.

Save Search Setup
After you have set up a Search configuration, you can save it as a SAS Search 
configuration file (*.ssh) or a SATA Search configuration file (*.tsh) by clicking Save. 
You can then use it on a different capture by clicking Load in the Search dialog.

Search Direction
Choose either Forward or Backward direction in which to perform the search.

Search From
Choose a starting point to begin or continue a search: Start of the sample file, 
Trigger Pointer, X Pointer, Y Pointer, or Last Found.
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Search Logic
The default setting is Or Selected Items. With this setting, clicking Find Next locates 
all selected items in turn. If you choose And Selected Items, you can set a logical 
AND combination of items to find. Both options allow setting Advanced search 
features.

Search For
Choose a category to search in the Search For window. Each of the search 
categories offers additional choices in the Search Items window to refine the search. 
Check items for the selected category.

Data Pattern
Search for Data Pattern allows you to search for a specific Data Type, Pattern, and 
Length (see Figure 245).

• Data Pattern Only
• Data Payload Length Only
• Data Pattern and Data Payload Length 

Advanced options
Some of the Search For categories offer advanced options for search. To set these 
options, highlight the search item in a category and click the Advanced button to open 
the Advanced options dialog.

Figure  247  Advanced Options Dialog Example: Set Device Bits
Set the options and click OK.

Search Domain
Click the Domain button and choose a search domain from all ports or a specific port.

Protocol Error
You can refine the search to locate packets with an error or without an error.

Note: When searching for Protocol Errors in Column View, you cannot search for a specific 
Protocol Error type. Search returns any protocol error.
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Search Sub Items
When searching SCSI Command Status, you can refine the search by selecting from 
a list of Sub Items.

Note: Some of the search categories allow you to refine the search by specifying specific 
SAS addresses and STP ports to search.

Figure 248.  Search Sub Items
When you check the SCSI Command Status, the Check Condition item appears in 
the Search Items Window, if a check condition has occurred. Clicking this enables 
Search Sub Items, allowing you to refine the search by specifying Sense Key, ASC, 
and ASCQ.



Display Manipulation

191

Search by Tag Number
To search by Tag Number, check the Tags box in the Search For window and then 
check the Tag(s) for which to search in the Search Items window.

Figure 249.  Search by Tag Number
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Display Configuration
The Analyzer ships with a default display configuration of field and viewer settings. 
You can define your own field and viewer settings for a particular testing scenario.

Sample Viewer Configuration
The Sample Viewer Configuration dialog allows you to change the following display 
settings:

• Field settings
• Data format
• Field header text color
• Hide/Show field

• Viewer Settings
• Change fonts
• Wrap packets
• Time Stamp Origin
• Enable/Disable tool tip

• Save Display Configurations in a file
• Load Display Configuration settings from a file
• Factory Setting (Restores Default Settings)
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To customize the display, click the  Configuration button on the Viewer 
toolbar, or select Configuration > Sample Viewer Configuration, to open the 
Sample Viewer Configuration dialog.

Figure  250  Sample Viewer Configuration
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Field Settings
To view a packet field, select a field from the packet field tree and check the Visible 
box. Uncheck it to hide the field. To change the data format of a packet field, select 
the field and choose a data format from the Format drop-down list.

Figure  251  SCSI Command Fields
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Color
To change the color of the text in a packet field header, select a field from the packet 
field tree and click the Foreground button.

Figure  252  Color
Choose an appropriate color and click OK.

Font
To change display fonts, click the Font button to open the Font dialog box.

Figure  253  Font
Choose the font, font style, and size, and click OK.
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Viewer Settings
Check the Wrap Packet box to enable the wrapping of packets in the display.

Check the Enable Tooltip box to enable tool tips for packet fields.

To change the length of long byte fields displayed, enter a number of bytes to display 
in the Long Field Byte Count size box.

Check Absolute Trig to display trigger in real time. If left unchecked, the trigger 
position is t=0 with samples before trigger shown as a (-) number and after trigger as a 
(+) number.

When finished, click OK to save changes and close the Display Configuration dialog.

Save/Load Settings
You can save the customized configuration settings in a *.cfg file by clicking the Save 
button and completing the Save As procedure. To load a previously saved 
configuration file, click Load and choose an appropriate file.
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Set Port Alias
Port Alias allows you to assign a meaningful name to each port to assist in interpreting 
the results displayed in the sample view.

To assign port names in an open sample view, select 
Configuration > Set Port Alias.

Figure  254  SAS: Assign Port Alias
Assign a meaningful name to each port in use and click OK. The assigned names 
replace the port numbers in the sample view.

If you elect to save the capture sample file, the assigned port names are saved 
together with the result, so that when you open the sample file later, the assigned 
names are retained.

Set As Default
If you want to set these port aliases for sample files that will be captured later, you can 
set them as default, and new samples will be opened by these default port aliases.
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SAS Address Alias
SAS Address Alias allows you to assign a meaningful name to each SAS address to 
assist in interpreting the results displayed in the sample view. To assign SAS address 
names in an open sample view, select Configuration > Set SAS Address Alias.

Figure  255  SAS: Assign SAS Address Alias
Assign a meaningful name to each SAS address in use and click OK. The assigned 
names replace the SAS address in the sample view, Search, filter,. and Statistical 
report.

Figure  256  SAS: SAS Address Alias
If you elect to save the captured sample file, the assigned SAS address names are 
saved together with the result, so that when you open the sample file later, the 
assigned names are retained.

Set As Default
If you want to set these SAS address aliases for sample files that will be captured 
later, you can set them as default, and new samples will be opened by these default 
SAS address aliases. 
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Tx Vout
The analyzer incorporates the ability to select TX Vout for the transmitter on each port. 
Selecting TX Vout increases the output voltage swing above the nominal value, for 
test and characterization purposes. This feature is also useful to compensate for line 
loss when driving long cables. 

To select TX Vout, select Configuration > Tx Vout & Preemphasis to display the  
Rx/Tx Settings dialog: 

Figure  257  Choose Port for TX Vout
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Software Settings
Software Settings allow you to define template files for new Analyzer projects, to 
specify how sample files appear when opened, and to set ATAPI Spec Assignment.

To perform software settings in an open sample view, select 
Configuration > Software Settings.

Figure 258.  SAS: Software Settings Dialog
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Figure 259.  SATA: Software Settings Dialog
Set the options and click OK.
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Floating License
The Floating License dialog displays the available functionality by Function, 
Total Ports, Assigned To ports, and Not Used. It also displays the 
Current License Configuration by License Type, Serial Number, Analyzer, 
Device Emulator, Host Emulator, and Infusion.
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External Trig Setting
The External Trig Setting dialog displays the External Trig Out Setting and 
External Trig In Setting as High Active, Low Active, or Toggle.

Figure 260.  External Trigger Setting Dialog
To display the External Trig Setting dialog, select 
Configuration > External Trig Setting.

External Trig Out Setting 
The Analyzer can send a Low or High external signal anytime a trigger occurs. Select 
the External Trig Out Setting: High Active, Low Active, or Toggle from High to Low or 
Low to High once (3.3 V output).
Enter the External TrigOut pulse width.

External Trig In Setting 
An external Low or High input signal can cause triggering. Select the 
External Trig In Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

Update STX Board Interface
The Update STX Board Interface dialog allows you to update the 
STX Board Interface.

Update Sierra Device
The Update Sierra Device dialog allows you to update the Sierra M6-4 Analyzer.
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USB IP Setup
If you are connected to a device using USB, you can use IP_SETUP to change the IP 
settings:

• DHCP automatically assigns an IP address. DHCP is the default.
• Static IP prompts you to enter a specific IP address. 

To change from DHCP to Static IP while connected to a device using USB:
1. Select Configuration > Setup IP from the menu bar. 

Figure  261  Configuration Menu with Setup IP Command
Note: If you are not connected to the device using USB, the Configuration menu does 
not have the Setup IP command.

The IP Setup dialog appears. For IP Mode, two radio buttons are available:  
Static IP and DHCP. DHCP is the default. 

Figure  262  IP Setup Dialog
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2. To change to Static IP, click the Static IP radio button.
Enter the Static IP Address.
Enter the Subnet Mask. 
Click Update. 
The system displays a warning message. 

Figure  263  Warning Message
Click Yes to get a success message.

Figure  264  SAS IP Setup Success Message
Click OK. The message closes and the device resets. 
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3. To change back to DHCP, in the IP setup dialog, click the DHCP radio button, then 
click Update.

Figure  265  SAS IP Setup Success Message
After you see the Warning Message, click Yes

After you see the Success Message, click OK.

Note: You can also click Reset.
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User-Defined Decoding
User-defined decoding allows you to create a definition file to interpret commands and 
frames that are not in the standard set recognized by the software.

Select Configuration > User Defined Decoding to open the User Defined Decoding 
dialog.

Figure 266.  SAS: User Defined Decoding
SAS vs. SATA: SAS adds SCSI Commands, SSP Frames, and SMP Frames.

Check ATA Commands and/or STP frames. Click the ellipses next to a command 
type text box to display the Open dialog. Choose an appropriate script file and click 
Open.

Figure  267  Choosing a Script File
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Statistical Report
Whenever a captured sample is in the Sample Viewer, a Statistical Report selection 
in the Report menu and a Statistical Report Button on the viewer toolbar are 
enabled. You can create a Statistical Report for the entire capture or select a portion 
of it.

To display a Statistical Report, click the  Statistical Report button on the 
viewer toolbar or select Report > Statistical Report to display the 
Select Statistical Report Range dialog. 

Figure  268  Statistical Report Range Dialog
The default statistical report has All Samples. You can set a specific Statistical report 
range between defined cursor positions or events.

Report between Cursors
Click the option button next to the From cursor selection drop down list. Then click the 
From down arrow and choose the 1st cursor, click the To down arrow to choose the 
2nd cursor, and click OK. The resulting report has only the capture between the 
cursors.

Figure  269  Report between Cursors
Report between Events

Click the option button next to the From the event selection dropdown list, click the 
From down arrow to choose the 1st event, then enter the number of its occurrence. 
Next click the To down arrow to choose the 2nd event, then enter the number of its 
occurrence.

Figure  270  SATA: Report between Events
Click OK. The resulting report are limited to the capture between the defined events.

SAS vs. SATA: SAS adds Transport, SCSI Cmd, SMP Cmd, and Task Mng to the 
drop-down list and deletes FIS and Phy Reset.
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Statistical Report Content
SAS: A complete SAS statistical report consists of the following reports, accessed by 
clicking the corresponding tab in the dialog:

• General
• Bus Condition
• Primitive
• SSP Transport
• SMP Transport
• STP Transport
• ATA Command
• SCSI Command
• SMP Command
• Task Command
• SAS Address
• Read/Write Command
• Protocol Error
• Performance
• Lanes
• Others

SATA: A complete SATA statistical report consists of the following reports, accessed 
by clicking the corresponding tab in the dialog:

• General
• Bus Condition
• Primitive
• FIS
• ATA Command
• ATAPI Command
• Read/Write Command
• Protocol Error
• Performance
• Others
• PM Statistic
• PM Performance

Note: Results are displayed only for items that have been captured in the sample.

Report Options
Some report categories offer options to display only specific items.These report 
categories incorporate drop-down list boxes offering pre-defined and custom options. 
For details see “Formatting the Statistical Report View” on page 226.
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General Report
To display the General Report, click the General tab. The General Report displays the 
report data in columns with the following information:

• Type
• Direction
• Duration
• Count (number of occurrences)
• % of total count 

Figure  271  General Statistical Report

Primitive Report
To display the Primitive Report, click the Primitive tab. The Primitive Report displays 
information in the following columns:

• Primitive
• Direction
• Count (number of occurrences)
• % of total count 

Figure  272  Primitive Report
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Bus Condition Report
To display the Bus Condition Report, click the Bus Condition tab. The Bus Condition 
Report displays information in the following columns.

• Bus Condition
• Direction
• Count (number of occurrences)
• % of total count

Figure  273  Bus Condition Report

ATA Command Report View
To display the ATA Command Report, click the ATA Command tab. The ATA 
Command Report displays information in the following columns:

• Command
• PM Port
• Direction
• Number of FIS
• Payload Size (Dwords)
• Status
• Timeout
• Duration
• Count (number of occurrences)
• % of total count 

Figure  274  SATA: ATA Command Report
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Protocol Error Report
To display the Protocol Error Report, click the Protocol Error tab.The Protocol Error 
Report displays the report data in columns with the following information:

• Protocol Error
• Direction
• Count
• % of count 

Figure  275  SAS: Protocol Error Report

Others Report View
To display the Others Report view, click the Others tab. The Others Report view 
displays information in the following columns:

• Items
• Idle No
• Payload Size
• Sample Time
• Idle (Initiator)
• Idle (Target)
• SSP Bus Utilization
• SMP Bus Utilization
• STP Bus Utilization

• Report
• Count/Time 

Figure  276  Others Report
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SSP Transport Report (SAS)
To display the SSP Transport Report, click the SSP Transport tab. The 
SSP Transport Report displays the report data in columns with the following 
information:

• Type
• Direction
• Duration
• Count
• % of count 

Figure  277  SAS: SSP Transport Report

SMP Transport Report (SAS)
To display the SMP Transport Report, click the SMP Transport tab. The 
SMP Transport Report displays the report data in columns with the following 
information:

• Type
• Direction
• Duration
• Count
• % of count 

Figure  278  SAS: SMP Transport Report
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STP Transport Report (SAS)
To display the STP Transport Report, click the STP Transport tab. The 
STP Transport Report displays the report data in columns with the following 
information:

• FIS Type
• PM Port
• Direction
• Duration
• Count
• % of count 

Figure  279  SAS: STP Transport Report

SCSI Command Report (SAS)
To display the SCSI Command Report, click the SCSI Command tab.The 
SCSI Command Report displays the report data in columns with the following 
information:

• Command
• Direction
• Number of Transport
• Payload Size
• Status
• Task Attribute
• Duration
• Count
• % of count 

Figure  280  SAS: SCSI Command Report
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SMP Command Report (SAS)
To display the SMP Command Report, click the SMP Command tab. The 
SMP Command Report displays the report data in columns with the following 
information:

• Function
• Function Result
• Direction
• Duration
• Count
• % of count 

Figure  281  SAS: SMP Command Report

Task Command Report (SAS)
To display the Task Command Report, click the TASK Command tab. The 
Task Command Report displays the report data in columns with the following 
information:

• Function
• Status
• Direction
• Duration
• Count
• % of count 

Figure  282  SAS: TASK Command Report

SAS Address Report (SAS)
To display the SAS Address Report, click the SAS Address tab.The SAS Address 
report displays the report data in columns with the following information:

• Source SAS Address
• Destination SAS Address
• Protocol Type
• Frame Type
• Count 

Figure  283  SAS: SAS Address Report
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Lanes Report (SAS)
To display the Lanes Report, click the Lanes tab. The Lanes Report displays the 
report data in columns with the following information:

• Port
• Open Accept
• Open Reject
• AIP Waiting on Con.
• Break
• SCSI Command
• ATA Command
• SMP Command
• Out Standing Command
• Transfer Bytes
• Link Utilization
• Link Utilization % 

Figure  284  SAS Lanes Report

Read/Write Command Report (SAS)
To display the Read/Write Command Report, click the Read/Write Command tab. 
You can enable or disable creation of this page under Software Settings (see 
“Software Settings” on page 200). The Read/Write Command report displays the 
report data in columns with the following information:

• Source SAS Address
• Destination SAS Address
• Protocol Type
• OpCode/Command
• Tag
• LBA
• Sector Count
• Xfer Length
• Payload Size
• Status
• Completion Time
• Performance
• Standard Deviation
• Count 

Figure  285  SAS: Read Write Command Report
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Read Write Command Report View (SATA)
To display the Read/Write Command Report view, click the Read/Write Command 
tab. You can enable or disable creation of this page under Software Settings (see 
page 200). The Read/Write Command Report view displays information in the 
following columns:

• Time Stamp
• OpCode/Command
• LBA
• Sector Count
• Payload size
• Status
• Completion Time
• Count 

Figure  286  SATA: Read Write Command Report

Performance Report View (SATA)
To display the Performance Report view, click the Performance tab. The 
Performance Report view displays information in the following columns:

• Minimum Completion time
• Average Completion time
• Maximum Completion time
• Host Bus Utilization
• Device Bus Utilization
• Efficiency (%)
• Total Read (DWords)
• Total Read Duration
• Total Write DWords
• Total Write Duration (time)
• Average Byte Per FIS 

Figure  287  SATA: Performance Report
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Performance Report (SAS)
To display the Performance Report, click the Performance tab.The Performance 
report displays the report data in columns with the following information:

• Min. Compl. Time
• Avg. Compl. Time
• Max. Compl. Time
• Init. Bus Utilization
• Target Bus Utilization
• Efficiency
• Total Read CMD
• Total Read Duration
• Cmd Min. Read (MB/S)
• Cmd Avg. Read (MB/S)
• Cmd Max. Read (MB/S)
• Total Write Cmd
• Total Write (Bytes)
• Total Write Dur.
• Cmd Min. Write (MB/S)
• Cmd Avg. Write (MB/S)
• Cmd Max. Write (MB/S)
• Total Write Duration
• Avg. Byte per SSP Frame
• Avg, Byte Per STP Frame 

Figure  288  SAS: Performance Report
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FIS Report View (SATA)
To display the FIS Report, click the FIS tab. The FIS Report view displays information 
in the following columns:

• FIS Type
• PM Port
• Direction
• Duration time (accumulative)
• Count (number of occurrences)
• % of total count 

Figure  289  SATA: FIS Report
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PM Statistic Report (SATA)
To display the PM Statistic Report, click the PM Statistic tab. The PM Statistic Report 
view displays information in the following columns:

• Request Type
• Request Port
• Response Type
• Response Time
• Request Entering Delay
• Response Entering Delay 
• Wakeup type 
• Request DC Idle Time 
• Response DC Idle Time 
• Request Wakeup Time 
• Response Wakeup Time 
• Count

Figure  290  SATA: PM Statistic Report
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PM Performance Report (SATA)
To display the PM Performance Report, click the PM Performance tab. The 
PM Performance Report view displays information in the following columns:

• Port
• Partial Request
• Partial ACKed
• Partial NACKed
• Slumber Request
• Slumber ACKed
• Slumber NACKed
• Percent of Ratio of the Partial Time to Slumber Time
• Percent of Ratio of the Partial Time to Total Time
• Percent of Ratio of the Slumber Time to Total Time 

Figure  291  SATA: PM Performance Report
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Statistical Report Toolbar
The Statistical Report toolbar provides the following functions accessible by buttons 
on the toolbar:

• Export to Excel
• Save as Text
• Print Report
• Print Preview
• Report Display Settings
• Move to X-Cursor, Y-Cursor, or None 

Export as Microsoft® Excel file

Save as Text file

Print Statistical Report

The Export to Excel button opens the Export to Excel dialog. Choose a folder in 
which to save the Excel file, choose an appropriate file name, and click Save.

The Save as Text button opens the Export to Text dialog. Choose a folder in which 
to save the Text file, choose an appropriate file name, and click Save.

The Print button opens the select printer dialog. Choose an available printer and 
click OK.
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Print Preview

Figure  292  Sample Print Preview of Report

The Print Preview button displays a preview of the report to print.
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Report Display Settings

You can set up the report columns for display to suit a particular analysis need, 
eliminating the need to show/hide columns individually. Use the Setting dialog to 
configure the display for each page.

Figure  293  SAS: Statistical Report Column Setting

Figure  294  SATA: Statistical Report Column Setting

The Setting button opens the Setting dialog.
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Link With Sample View
When you select a type on any page of the Statistical Report, a set of navigation 
buttons allows you to examine each instance of that type in the Sample Viewer. 

The Jump to Previous button goes to the previous instance of the selected type in 
the Sample Viewer.

The Jump to Next button goes to the next instance of the selected type in the 
Sample Viewer. 

The Jump to Specific button goes to the instance specified as N of M items on the 
Statistical Report toolbar.

       The Move drop-down list moves to the X-Cursor, Y-Cursor, or None.
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Formatting the Statistical Report View
Initially the Statistical Report View contains all of the information in columns, but you 
can customize the display by:

• Filtering columns by item
• Sorting items by column
• Hiding any column on the display

Filtering Column Content
To filter column content, click the down arrow in the heading for that column and 
choose the items to display. The default is All. By checking a specific item, you 
exclude everything but that item for display.

Figure  295  SAS: Type

Choosing Custom allows you to specify more than one item for display.

Figure  296  SAS: Custom Filter



Statistical Report

227

.

Figure  297  SATA: FIS Type

Choosing Custom allows you to specify more than one item for display.

Figure  298  SATA: Custom Filter
Check the items to display and click OK.
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Sorting Column Content
To sort column content, click the heading for that column. Repeated clicking of the 
column heading sorts the column in ascending or descending order.

Figure  299  Toggling Type Sort Order

Hiding Columns
To hide a column, right-click in the column and choose Hide. To unhide a column, 
right-click any column and choose Unhide.
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Data Report
When a captured sample is in the Sample Viewer, the Data Report button is on the 
Viewer toolbar, and Data Report is in the Report menu.

The data report displays all the data sent from the host to the device and from the 
device to the host. All PIO In =>In commands are grouped as a data packet until the 
occurrence of a PIO Out =>Out command, creating a new data packet.

To display a Data Report, click the  Data Report button on the Viewer 
toolbar or select Report > Data Report.

Figure  300  SAS: Data Report
Click the Down Arrow in a data field to display Data Report details.

Figure  301  SAS: Data Report Details
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Click the Statistics button  at the end of a row to display data report 
statistics.

Figure  302  SAS: Data Report Statistics
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Tools
The Tools are Self Test and Find Device.

Self Test
You can use the built-in RAM self-test utility. Select Tools on the main menu bar and 
choose Self Test.

Figure  303  SAS: Self Test Command on Tools Menu

SAS vs. SATA: SATA adds Compliance Test.

The Self Test dialog opens.
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Memory Check
To perform a SDRAM or Exerciser RAM memory check, select the Memory tab.

Figure  304  Self Test Dialog Memory Tab
Choose the SDRAM, Exerciser Data, or Exerciser Instruction to test and click the 
Start Memory Check button. After a short time, the Test Result appears to the right of 
the selected line.

Test Result: OK or Error
If a test is OK and you specified one run, the Test Result is OK: 1 times.

If a test has an error and you specified one run, the Test Result is Error: 1 times.

Saving
You can save any check result by checking the Save error details check box and 
specifying a destination file name.
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Number of Runs Each Test
You can specify to run a test more than once.

Run All Tests Sequentially
This option runs all items in the Clock, Memory, Serdes, Crosspoint, Main FPGA, 
Expansion, and LED/Buzzer tests in order. After you check this check box, the 
command button becomes Start All Tests. You must click the Stop Test button on 
the LED/Buzzer tab to stop the check.

Clock Check
To perform a Clock check, choose the clock to test and click the Start Clock Check 
button. After a short time, the Test Result appears to the right of the selected line. 

Figure  305  Self Test Dialog Clock Tab
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Marvel Check
To perform a Marvel Chip check, select the Marvel tab.

Figure  306  Self Test Dialog Serdes Tab
Choose the Marvel Chip to test and click the Start Marvel Check button. After a short 
time, the Test Result and Marvel Failure Type appear to the right of the selected line. 
Marvel Failure Type indicates the error type.
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Virtex Check
To perform a Virtex-Virtex bus test check, select the Virtex tab.

Figure  307  Self Test Dialog Crosspoint Tab
Choose the Virtex-Virtex bus test to test and click the Start Virtex Check button. After 
a short time, the Test Result appears to the right of the selected line.
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Vitesse Check
To perform a Virtex Pair Line or Virtex Link check, select the Vitesse tab.

Figure  308  Self Test Dialog Main FPGA Tab
Choose the Virtex Pair Line or Virtex Link to test and click the Start Vitesse Check 
button. After a short time, the Test Result appears to the right of the selected line.
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Expansion Check
To perform a Expansion Card Data Status or Clock Status check, select the 
Expansion tab.

Figure  309  Self Test Dialog Expansion Tab
Choose the Expansion Card Data Status or Clock Status to test and click the 
Start Expansion Check button. After a short time, the Test Result appears to the 
right of the selected line.
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LED/Buzzer Check
To perform a LED or Buzzer check, select the LED/Buzzer tab.

Figure  310  Self Test Dialog LED/Buzzer Tab
Check LED Test or Buzzer Test and click the Start LED/Buzzer Check button. For 
the LED, you should see the LED pattern. For the buzzer, you should hear it sound. 
You must click the Stop Test button to stop the check.
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Find Device
Saving device information allows you to import the specific device information into the 
Target/Device emulator.

The Find Device utility obtains all vendor-specific information and detailed device 
parameters.

Select Tools on the main menu bar and choose Find Device.

Figure  311  SATA: Find Device Command on Tools Menu
SAS vs. SATA: SATA adds Compliance Test.

The Device Identifier dialog opens.

Figure  312  Device Identifier Dialog
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Click the Find Device button to search for connected devices. After a brief period, the 
dialog displays all device information.

Figure  313  Identified Devices
Click a device in the Device List to display information about that device.
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Compliance Test (SATA)
The Compliance Test consists of a set of selectable tests to verify compliance with the 
SATA specification.

To run a Compliance Test:

1. Select Tools on the main toolbar and choose Compliance Test to open the 
Compliance Test dialog.

Figure  314  SATA: Compliance Test Selection
2. Choose the tests in the left pane of the dialog and click the Add>> button.

3. Enter a value for Capture Timeout.
Note: If test running time exceeds the Capture Timeout value, the test terminates.

4. To view failed test traces in the sample viewer, check the 
Automatically load failed test traces check box.

5. To save the failed test traces only, check the Save only failed test traces 
check box.

6. After you select tests, click Start. 
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7. The test runs and, after a brief period, displays the result.

Figure  315  Compliance Test Result
8. To save the current compliance setup for later use, click the Save button to 

open the Save As dialog. Assign a meaningful name to the setup and save it as 
a *.cst compliance file.

9. To run a previously defined setup, click the Load button and choose a 
previously defined setup to run.
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Infusion Overview
The LeCroy Infusion™ Error Injector and Traffic Modifier is an error injector and traffic 
modification tool that allows you to verify real-world fault handling for 
Serial Attached SCSI (SAS) and Serial ATA (SATA) systems. Infusion can sit 
unobtrusively in the data path on a live system to programmatically alter or corrupt 
traffic. Infusion is the ideal tool for stress-testing systems using actual workloads.

Figure  316  Infusion Windows
Infusion supports SAS SSP, SMP, STP, and SATA-based protocols operating across 
a single SAS or SATA link up to 6 G. Infusion monitors traffic from both directions in 
real-time and relies on predefined rules to replace any bit, primitive, or parameter with 
one you specify. Infusion can change traffic when it detects a specific sequence or 
reaches a designated time interval, yet it requires no complicated scripts, 
programming, or simulation tools.
Infusion can monitor traffic in both directions and act on events occurring in either 
direction of the communications link. Infusion can modify traffic in only one direction 
within a given test scenario, but that direction can be either from the Initiator or from 
the Target.
Infusion is specifically designed to verify recovery characteristics within a subsystem. 
An easy pop-up menu interface allows you to create specific test scenarios in just 
minutes. 
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Once a Infusion session starts, the system automatically handles protocol 
handshaking between devices. Infusion transmits a faithful copy of the original data 
stream down to the CRC value which, if needed, it recalculates. Infusion allows test 
engineers to systematically verify error recovery in ways not possible with other test 
platforms.

Key Features
The key features of Infusion are:

• Error Injection: Injects CRC, disparity, 8b/10b encoding, framing, and coding 
errors.

• Break Link Recovery: Programmatically breaks the connection to test link 
recovery.

• Value Replacement: Monitors the link for specific values, patterns, or primitives (as 
low as bit level) and replace with user-defined values. You can replace values on 
every occurrence, after a specified number of occurrences, or after a specified time 
interval.

• Packet Drop: Removes individual primitives, address frames, or data frames from 
the stream to verify retry behavior.

• Primitive Manipulation: Replaces handshaking and flow control primitives to help 
validate robustness of a design. 

• Traffic Monitoring: Operates as a traffic monitor, collecting statistical data on user-
specified parameters. In this mode, data passes unchanged in both directions. 

• Menu-Driven Interface: Allows easy set-up of test scenarios.

• API based on C++: Allows development of custom test applications.

With respect to traffic modification, in the Link Layer you can modify primitives, CRC, 
scrambled traffic, and SSP, SMP, and STP connection events. You cannot modify 
clock skew management, OOB and power management, and signal integrity.

Infusion consists of a hardware device that connects to the line under test and a 
Windows-based software application used to create and download test scripts to the 
device. You also can use the software application to configure and control the device 
across an Ethernet link.

Infusion test scripts are called scenarios. Scenarios determine how the hardware 
device monitors and modifies line traffic. You must use the application to create and 
download scenarios.

For the Infusion connections, the device is connected between the SAS/SATA host 
and the PHY of the test target (DUT). 
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Interface
Buttons

The Infusion interface has the following command buttons:

New Scenario: Begins the scenario creation process by listing Scenario Name, 
Direction for traffic changes, and Global Rules in the scenario window.

Open Library: Lists the Infusion Library Files (.infdb), which contain the available 
scenarios, in an Open dialog.

Save: Saves the current scenario in the UserData folder.

Download Scenario: Downloads a scenario.

Print: Prints the current scenario.

Show File Manager: Displays/hides the File Manager window (on the right), which 
displays folders and files in a Windows-Explorer type listing, so that you can locate the 
main and other library files and their scenarios.

Show Library: Displays/hides the Main Library window (on the right), which displays 
the available scenarios. You can create a new scenario, save a selected scenario, 
save the library, save a copy of the library, display the selected scenario, insert a copy 
of the selected item, or delete the selected scenario.

Show Output: Displays/hides the Output window (at the bottom), which displays 
Infusion output. Use the buttons to save output, print output, display options 
(automatically save the log file, with a path and size), start logging, stop logging, and 
clear the Output window.

Show Device Library: Displays/hides the scenarios of the current device library.

Show Analyzer: Returns to the Protocol Analyzer or Target/Host Emulator window.

Rec Analyzer: Starts recording on the current analyzer, using the current scenario.

Stop: Stops recording on the current analyzer.

Abort: Aborts recording.

Menus
The Infusion interface has the following menus:

File: New Scenario, Open Scenario, New Library, Open Library, Close Library, 
Save Library, Save a Copy of Library As, Open Log File, and Print Setup (see 
command descriptions in the “Buttons” section above).

View: Views (File Manager, Library, Output, Customize; see window descriptions in 
the “Buttons” section above), Smart Docking, Toolbar, and Status Bar

Configuration: Update Sierra Device (see “Update Sierra Device” on page 203) 
                          Configure Device (see “Show Device Library” above) 
                          Port Configuration (see “Port Configuration for Infusion” on page 246) 
                        External Trig Setting (see “External Trig Setting” on page 203)

Tools: Browse UserData, System, or Infusion folder.

Help: Help Topics and About Infusion.
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Port Configuration for Infusion
The Infusion (Jammer) port configurations must match the Analyzer port 
configurations for the infusion-analyzer to work. 

Select Configuration > Ports Configuration to display the Ports Configuration 
dialog. Port configuration depends on the application you run. To act as an  
infusion-analyzer, select the Analyzer/Jammer/Analyzer port configuration.

In the following figure, the third row has a match on the H3/D3 port. 

Figure  317  Ports Configuration Window with Infusion/Analyzer Port Match



Infusion Scenarios

247

Infusion Scenarios
You can create and execute Infusion scenarios. A scenario is a test script that defines 
how Infusion monitors and modifies line traffic.

Note: When specifying the direction of traffic in scenario events, you have a choice of eight 
directions (from I1, T1, I2, T2, and so on). Only “From I1” and “From T1” are valid 
selections, since only one channel is supported.Any other selection generates an 
error message.

Scenarios Overview
You create scenarios on a PC running the Infusion application. You then download 
the scenarios for execution on an Infusion device. You can download up to ten 
scenarios to each Infusion device.

The Infusion application provides a menu-driven interface for building scenarios. The 
interface prompts you for simple decisions and choices from drop-down menus. As 
you make your selections, the script takes shape automatically in the scenario 
window. The script is in the form of simple English sentences. You need not 
understand any formal scripting language. 

Figure  318  New Scenario in Infusion Window
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As described later in this chapter, you can create any number of scenarios and store 
them in libraries on the PC hard drive. Scenario library files names are in the following 
format: 

<filename>.infdb

Creating Infusion scenarios is easy, but it requires an understanding of the following 
terms defined in Table 1.

Key Scenario Terms

Global Rules
Global Rules are a portion of the scenario that can define only one test state. To 
create the Global Rules, you use the menu-driven interface to enter an event or 
combined event and the corresponding action or set of actions (the response of 
Infusion hardware to the event).

In the case of a combined event, the action is taken upon occurrence of any of the 
events stated for the event combination. It is a logical OR association, meaning any of 
the events can trigger the action.

After you enter the event or combined event, the interface prompts you for actions. An 
action might be, for example, injecting a particular primitive or error into the traffic 
stream. You can enter multiple actions, which take place simultaneously. 

After defining the event and actions within the Global Rule area, you can save the 
scenario and download it to a Infusion device.

Term Definition

Action Infusion response to an event.

Event Condition that is detectable by Infusion.

Combined Event Logical OR association of events (for example, event A OR event B).

Global Rules Portion of a scenario that can define a single Infusion test state. You can think 
of the Global Rules and each sequence as a separate test routine or program 
operating within the scenario. Each operates independently and in parallel with 
the others. The purpose of each is to detect events and then respond with the 
appropriate action or set of actions. In essence, you can operate up to three 
test states simultaneously within Infusion.

Sequence Portion of a scenario that can define multiple Infusion test states. More flexible 
than the Global Rules, a sequence allows more powerful scenarios that include 
branching and looping between test states (Global Rules can define only a 
single test state, so there is no branching).

State “Behavior” of the Global Rules or a sequence at any point in time. In terms of 
Infusion testing, behavior is “waiting” for a set of events and responding with a 
set of actions.
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Sequences
The Global Rules are all you need for simple test scenarios. However, a scenario also 
can contain one or two sequences, which can define multiple states and allow 
branching between states. With a sequence, you also can do looping, which allows 
you to repeat a test state or to execute a test for a specified period of time.

As with Global Rules, the menu-driven interface guides you in building a sequence. 
Some of the prompts are different, however, because you now are encapsulating 
groups of events and actions as distinct states. Recall that a state is a combination of 
events and actions at a specific point in time. If the event or combined event defined 
by a state occurs, the corresponding action or set of actions follows.

Figure  319  Global Rules and Sequence Areas of a Scenario

Infusion hardware provides the capacity to have up to two sequences co-existing in a 
scenario in addition to the Global Rules. Recall that both the Global Rules and any 
sequences are active at all times. Each is a separate “state machine,” having the 
behavior of a particular test state at any point in time. Because the Global Rules has 
the capacity for only one state, you can view it as a “degenerative state machine.”
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Scenario Libraries
You can create any number of scenarios, which you then can archive on your PC hard 
drive. You also can download up to ten scenarios to each Infusion device for test 
execution. You can think of the libraries as windows that hold scenarios. 

Recall that each library is a separate *.infdb file.

Main Library
When you launch the Infusion application, it opens a window called the Main Library. 
The main library is the default workspace for creating and storing new scenarios. The 
main library corresponds with the following file in the Infusion folder on the PC 
hard drive:

DEFAULT.INFDB

File Libraries
You can save the main library with a name other than default (while still using the 
.infdb file extension). The new file becomes a file library that is functionally equivalent 
to the main library with the following exception: It does not open by default in the 
Main Library window. You can navigate to other file libraries using the File Manager of 
the Infusion application.

In this manual, the main library and other .infdb file libraries are collectively called 
general libraries.

If you select Open Library, you see a window similar to the following:

Figure  320  Open Library File List
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By selecting the TestCasesForSATA.infbd file, you get an additional library window 
with predefined SATA test cases, similar to the following:

Figure  321  Test Cases for SATA Library

Device Libraries
In addition to general libraries, the application defines device libraries. Each device 
library is associated with a specific Infusion device. Each device library opens in a 
separate Device Library window and holds up to ten Infusion scenarios for the device. 
When you connect to the device and click the entry for that device in the Device List, 
the device library for the device opens automatically. 

The scenarios that appear in the device library are those currently stored on the 
corresponding device. They were uploaded from the device to your PC when you 
opened the device library. You can click any of the scenarios listed to open it for 
editing. When you are finished with your edits, you can use the buttons on the 
Device Library toolbar to download the revised scenario to the device.
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Scenario Properties
To begin the scenario creation process, you click the New Scenario button in a library 
window or on the Infusion application toolbar. As the first step in creating a scenario, 
the application prompts you for scenario name, a short description (optional), and the 
direction of traffic to which any traffic changes apply. Changes are, for example, 
injection or removal of data or a primitive.

You identify direction of traffic change, or modification, in terms of traffic origin. The 
application uses the following conventions:

• From Initiator: Change is made to traffic coming from test host (for example, CRC 
error is injected into traffic stream sent from initiator to target).

• From Target: Modification is made to traffic coming from the target (for example, 
CRC error is injected into traffic stream sent from target to initiator). 

The figure shows the first prompt in the scenario creation process.

Figure  322  Entering Basic Scenario Information
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When you click the Scenario Name or the Direction For Traffic Changes, the 
Scenario Properties dialog box appears, allowing you to enter the scenario name, a 
short description, and direction of traffic change.

Figure  323  Scenario Properties Dialog Box

In the Scenario Properties screen, the direction for traffic modification is defined on a 
global basis for the entire scenario. In other words, any scenario action that modifies 
line traffic only affects the traffic flowing in the direction established at the top of the 
scenario, in the Scenario Properties. Scenario events can be monitored in either 
direction, and therefore the parameters for events provide the ability to specify the 
intended direction for monitoring traffic for that event.
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Scenario Events
A scenario is a script you create using simple mouse clicks and text entries. As you 
work, the script takes shape in the scenario area of the application display. You can 
think of the scenario area itself as consisting of two subareas: A Global Rules area at 
the top, where you create the Global Rules, and a Sequence area beneath the 
Global Rules, where you create any sequences. Whether you are creating 
Global Rules or a Sequence, the menu-driven interface prompts you to specify the 
event(s) for which you want to trigger actions.

Figure  324  Event Properties Dialog
While many events are line conditions, an event also can be a condition that occurs 
within a Infusion device (for example, detection of a trigger signal from another 
device).  
The following table lists supported events. Note that some events are applicable only 
in the context of creating sequences (those events appear on the drop-down list only if 
you are creating a sequence). Sequences can have multiple states, and they allow 
branching between states.
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Events

The following sections provide some additional details about three of the above 
events.

Event Description

Address Frame Occurrence of a specified address frame.

Any Dword Occurrence of any dword.

ATA Command Occurrence of a particular ATA command.

ATA Command Frame Occurrence of a particular ATA command frame.

[+] ATAPI Occurrence of a particular ATAPI command from the list: 
MMC4, RBC, SBC2, SMC2, SPC2, SPC3, or SSC2.

Both Links Up Occurrence of both line ports active (not idling).

CRC Error Occurrence of a CRC error.

Dword Matcher Occurrence of a particular dword.

FIS Frame Occurrence of a particular FIS frame.

FIS Type Occurrence of a particular SATA FIS type.

Frame Type Occurrence of a particular frame type.

Invalid 10bit-code Error Occurrence of an invalid 10b code.

Links Speed 3G Both lines operating at 3 Gbps.

Links Speed 6G Both lines operating at 6 Gbps.

OOB Signal Occurrence of OOB signal.

[+] Primitives Occurrence of Primitive Group, SAS Primitive, or SATA Primitive.

Running Disparity Error Occurrence of Running Disparity (RD) error.

SAS Data Pattern Occurrence of a particular data pattern in a SAS frame.

SATA Data Pattern Occurrence of a particular data pattern in a SATA frame.

{+} SCSI Occurrence of a particular SCSI command from the list: 
MMC4, RBC, SBC2, SMC2, SPC2, SPC3, or SSC2.

SMP Frame Occurrence of a particular SMP frame.

SSP Frame Occurrence of a particular SSP frame.

Timer Occurrence of a particular elapsed time (time period).

Trigger Input Occurrence of input trigger.
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Dword Matcher
Dword Matcher is a dword pattern matcher that presents match and mask fields and a 
K-Code Mask field. K-Codes are control characters that are always used in the first 
byte of a four-byte primitive. Of the K-Code masks listed in the menu, D-D-D-D is used 
for data bytes, and K-D-D-D is used for all primitives.

When you create a dword match, keep the following in mind:

• The pattern can be inside or outside of frames (it does not matter if the pattern is 
inside a frame or not).

• Because the pattern can be inside or outside of frames, there is no offset.

• You can make user-defined primitives. (This is the reason this feature was created.)

• You can use any K/D pattern.

SAS Data Pattern
When you create a SAS data pattern, keep the following in mind:

• The pattern must be defined inside a frame that starts with a SOF or SOAF.

• The pattern must be data only (no K-codes/primitives).

• The pattern must be defined at a specific offset in the frame.

• The pattern and mask must be specified in the same format as specified in the SAS 
standard:  
0x12345678 (hex) 
where “1” is the first digit on the cable and is the MSB as given in the SAS Standard.

For example, for an SMP Request:

Pattern: 0x40000000
Mask: 0xFF000000
Offset: 0
SOF Type: SOF

SATA Data Pattern
When you create a SATA data pattern, keep the following in mind:

• The pattern must be defined inside a frame that starts with a SATA_SOF.

• The pattern must be data only (no K-codes/primitives).

• The pattern must be defined at a specific offset in the frame.

• The pattern and mask must be specified in the same format as specified in the 
SATA Standard.

For example, for Register H -> D FIS:

Pattern: 0x00000027
Mask: 0x000000FF
Offset: 0
SOF Type: SATA_SOF
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Scenario Actions
After you enter the set of events for a test state, the menu-driven interface prompts 
you for the corresponding action or set of actions. If you define multiple actions, the 
actions occur simultaneously. 

Figure  325  Action Properties Dialog

The following table lists supported actions. Note that some of these actions only apply 
to creating sequences.
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Test State Actions

1 Only shown in Action Properties dialog box when creating a sequence.

Action Description

Beep Emits audible sound of duration selectable via drop-down list.

Branch to
 

Existing State1 Go to a state in this sequence that is already defined.1

New State1 Go to a state in this sequence that is not yet defined (you need 
to define it).1

Capture Data Dword Captures a data dword into one of four registers.

Inject CRC Error Injects a CRC error into the line.

Invalid 10bit-code Error Injects invalid 10b code into the line.

Running Disparity Error Injects a Running Disparity (RD) error into traffic.

Link Disconnect Puts both Infusion SAS ports at electrical idle immediately.

Reconnect Starts traffic pass-through immediately. This action restarts 
traffic after a previous disconnect command. Once traffic is 
passing through, the initiator and target resume OOB signaling.

Monitor/Count Opens a window to count the number of events that occur 
during a session. A session is a time interval during which a 
scenario runs.

Remove Removes the targeted event from the traffic.In Infusion, a 
Remove primitive action is implemented by replacing the 
primitive with an idle data dword. A Remove frame action is 
implemented by replacing the start-of-frame and end-of-frame 
primitives with an idle data dword.

Restart  All Sequences1 Restart all sequences in the scenario.1

Current Sequence1 Restart the sequence that contains this action definition. 1

Stop Scenario Stops all scenario activity.

Substitute Data Dword Substitutes a data Dword in the traffic.

with SAS Primitive Substitutes a SAS primitive in the traffic.

with SATA Primitive Substitutes a SATA primitive in the traffic.

Trigger Output Sends a signal out the trigger port to the device downstream.
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Using Counters in Events and Actions
Many of the events and actions supported by Infusion also support counters that can 
control functions.

Within events, counters determine how many times the event must occur before the 
associated actions are triggered. Event counters typically have two properties:

• Count Randomly: Can be set to “Yes” or “No” (default value is “No”).  
If set to “Yes”, the event repeats a random number of times (between 1 and the value 
set in the property Max Random Count, which replaces the property 
Counter Value when “Yes” is selected), before the action is triggered.

• Counter Value: Number of repeats required when Count Randomly is set to “No”. 
The default value is 1.

Within actions, counters determine how many times the system calls the action before 
it acts. Action counters typically have two properties:

• Random: Can be set to “Yes” or “No” (default value is “No”).  
If set to “Yes”, the action triggers a number of occurrences before the action takes 
place. That number ranges randomly between 1 and the value set in the property 
At least every Nth occurrence, which replaces the property 
Every Nth occurrence when “Yes” is selected.

• Every Nth occurrence: Number of times the system calls the action before it acts.

Note that there is some overlap in the way these counters can be used. For example, 
in the simple case of a single event leading to a single action, it makes no difference 
whether you specify the event to require five repeats before triggering the action, or 
the action to require five occurrences before it acts.

However, in the case of combined events and/or actions, the separate counters 
provide flexibility in designing test cases. For example, consider the case where 
Event_1 OR Event_2 leads to Action. If Event_1 has a counter of 5, then the Action 
triggers either when Event_1 has repeated five times or when Event_2 happens the 
first time, whichever occurs first.

But if the event counters are set to 1 and the Action counter is set to 5, then the Action 
happens after five occurrences of EITHER Event_1 or Event_2.



Infusion Scenarios

260

Capturing a Data Dword
Infusion provides the ability to capture individual data dwords and provides four 
different registers to store captured dwords (Dword #0, #1, #2 and #3).

To capture a data dword, select Capture Data Dword from the Action Properties 
screen, as shown below. Select the register to be used to store the dword from the 
drop-down menu under the Capture Register property.

Figure  326  Capture Data Dword Action
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Using Captured Data Dwords
Captured data dwords can be used in creating events for data that match the captured 
dword(s), or in creating actions to substitute the captured dword(s) into the data 
stream.

To create an event using the captured dword, in the Event Properties menu, select 
SAS Data Pattern (or SATA Data Pattern), and then select any of the 12 dwords 
(Dword 0 Type through Dword 11 Type). The drop-down menu provides the choice 
of a custom dword or any of the four captured dwords. If you select a captured dword, 
the Value field beneath this selection is hidden (the Value field is only used for 
specifying custom dwords). Note that choice of a mask and an offset are still available 
when using captured dwords.

Figure  327  Using a Captured Dword in a SAS Data Pattern
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Captured data dwords may also be used in the Substitute Data Dword test state 
action. From the Action Properties screen, choose Substitute Data Dword and then 
select the Substitute for property. A drop-down menu is provided (see below) that 
allows the choice of a custom dword or any of the four captured dword registers.

Figure  328  Using a Captured Data Dword in Substitute Dword Test Action

Summary of Scenario Creation
The suggested process of creating and executing a scenario is as follows:

Step 1 Create a scenario in the main library.

Step 2 Copy the scenario from main library to a device library by drag-and-drop with 
a mouse. (Each device library is associated with a specific Infusion device.)

Step 3 Download all scenarios in the device library to a Infusion device.

Step 4 Select the scenario in the device library that you want to run on the device.

Step 5 To run the scenario, click the Start Scenario button from the Device Library 
toolbar. The device starts to monitor/modify traffic.

Note:  Step 1 is described in detail for each example in following sections. Steps 
2 to 5 are described in detail at the end of this chapter.
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Creating Global Rules
This section gives examples for creating the Global Rules area of a scenario. Recall 
that the Global Rules area defines a single test state. The Global Rules do not have 
the capacity for multiple states, so that area of a scenario cannot change state.

In terms of Infusion testing, a state defines test “behavior.” In this context, behavior is 
“waiting” for an event and responding with an action or set of actions that happen 
simultaneously. 

Keep in mind that a test state you implement with the Global Rules operates in parallel 
with the active test state of each sequence in the scenario. 

In effect, Infusion lets you do up to three line tests at the same time. You can do one 
test with the Global Rules and a separate test with each sequence you create. You 
can have up to two sequences in a scenario. 

The following table summarizes the Global Rules examples that follow.

Global Rules Examples

Example Description

1 Creating a single event and action (removes a primitive).

2 Creating a single event and action (replaces a primitive).

3 Creating a combined event (a logical OR association of multiple events) and an action.

4 Creating multiple triggers and actions.

5 Creating multiple actions on a single event.

6 Using timers.
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Example 1: Creating a Single Event and Action that Removes a 
Primitive

In this example, the Global Rules area of the scenario waits for each RRDY Normal 
primitive from the initiator and removes it.

Step 1 Click the New Scenario button in the main library or one of the device libraries.

Step 2 In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change (see Figure 323 on page 253).

Step 3 In the Global Rules area, click the prompt to add an event.

Figure  329  Example 1: Adding an Event
The Event Properties dialog box appears (see Figure 324 on page 254). 

Step 4 In the Type column of the Event Properties dialog, choose 
Primitive > SAS Primitive.

Step 5 In the Type column in the middle of the dialog box, click Description if you 
want to add a description of the event. 

Step 6 Click Direction to choose the direction of traffic to monitor for the selected 
event (the default is From Initiator, which is what you want for this example). 
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Step 7 Still in the middle column of the Event Properties dialog box, click Primitive to 
display a drop-down menu that lets you choose the type of primitive for which 
you want to wait in this scenario. In this example, it is RRDY (Normal).

Figure  330  Example 1: Event Drop-Down List

Step 8 Click OK to close the Event Properties dialog box.
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Step 9 In the Global Rules area, click the prompt to add an action.

Figure  331  Example 1: Entering an Action
The Action Properties dialog box appears (see Figure 325 on page 257).

Step 10 In the Type column on the left, choose the action that you want to occur when 
an RRDY is detected. In this example, it is the Remove action. In Infusion, a 
Remove primitive action is implemented by replacing the primitive with an idle 
data dword.

Step 11 Click OK to close the Action Properties dialog box.

Figure  332  Example1: Complete Scenario

Step 12 In the File menu, select Save Scenario to save the scenario.
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Example 2: Wait for a Primitive and Replace It with an Error
In this example, the Global Rules portion of the scenario waits for each RRDY Normal 
primitive and replaces it with an ERROR primitive.

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 In the Global Rules area, click the prompt to add an event to display the 
Event Properties dialog box.

Step 3 As you did in the previous example, choose RRDY (Normal) as the type of 
primitive to monitor.

Step 4 In the Global Rules area, click the prompt to add an action to display the 
Action Properties dialog box.

Step 5 In the Type column on the left, choose Substitute > with SAS Primitive as the 
action that you want when an RRDY (Normal) occurs.

Step 6 In the middle column of the dialog box, click Description if you want to add a 
description of the action.

Step 7 Still in the middle column of the Event Properties dialog box, click Primitive to 
display a drop-down menu that lets you choose the type of primitive for which 
to substitute for RRDY (Normal) (see Figure 330 on page 265). Choose 
ERROR.

Step 8 Click OK to close the Action Properties dialog box.

Step 9 In the File menu, select Save Scenario to save the scenario.

In this example, you set the substitution action to happen at every occurrence of an 
RRDY (Normal) (as shown in the figure, the action is set for every occurrence). 
However, you can set an action to happen at other multiples of event occurrence (for 
example 5, 25, 1000 and so on). You also can set the action to happen at random, 
within a specified number of event occurrences. 

Figure  333  Example 2: Complete Scenario
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Example 3: Creating OR Conditions
In this example, the Global Rules area of the scenario waits for either of two types of 
RRDY primitive and replaces them with an ERROR primitive.

This example includes a combined event (a logical OR association of two or more 
single events). Here, the combined event consists of any occurrence of RRDY 
(Normal) or RRDY (Reserved 0).

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 In the Global Rules area, click the prompt to add an event to display the 
Event Properties dialog box.

Step 3 As you did in example 1 of this chapter, choose RRDY (Normal) as the first 
primitive that you want to monitor.

Step 4 Click the add combined event prompt to add a second event. 

Figure  334  Example 3: Entering the Second Event
The Event Properties dialog box appears.

Step 5 Choose RRDY (Reserved 0) as the second primitive that you want to monitor. 
Step 6 Click OK to close the Event Properties dialog box. 
Step 7 In the Global Rules area, click the prompt to add an action to display the 

Action Properties dialog box.
Step 8 In the Type list on the left, choose Substitute SAS Primitive as the action that 

you want when either RRDY Reserved 0 or RRDY Normal occurs.
Step 9 Click OK to close the Action Properties dialog box.



Infusion Scenarios

269

Step 10 In the File menu, select Save Scenario to save the scenario.

Figure  335  Example 3: Complete Scenario
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Example 4: Multiple Triggers and Actions
In this example, the Global Rules area of the scenario waits for two events, each of 
which triggers a different action.

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 As you did in example 2, choose RRDY (Normal) as the first event to monitor, 
and substitute with the SAS primitive ERROR as action.

Step 3 In the Global Rules area, click the prompt to add the next event (keep in mind 
this is not a combined event).

Figure  336  Example 4: Entering Second Event
The Event Properties dialog box appears.

In this example, there is a parallel set of events, but each event is associated with its 
own action. In a combined event, there is a parallel set of events sharing the same 
action.

Step 4 Using the drop-down menu, choose RRDY (Reserved 0) as the second event 
to monitor.

Step 5 Click OK to close the Event Properties dialog box.
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Step 6 In the Global Rules area, click the prompt to add an action to be triggered by 
the RRDY (Reserved 0).

Figure  337  Example 4: Entering Second Action

The Action Properties dialog box appears.

Step 7 Use it to choose Inject RD Error as the action triggered by 
RRDY (Reserved 0).

Step 8 Click OK to close the Action Properties dialog box.

Figure  338  Example 4: Complete Scenario

Step 9 In the File menu, select Save Scenario to save the scenario.
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Example 5: Multiple Actions on a Single Event
In this example, an event triggers a set of actions. The actions occur at the same time. 
The device waits for an ACK from the initiator. When it occurs, the device beeps, 
injects an RD error, and increments a counter monitoring for that event (ACK from 
initiator).

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 As in previous examples, configure the first event and its response in the 
Global Rules area. Choose ACK primitive as the event and Beep as the action. 
From the Action Properties drop-down menu, enter 500 ms as the duration of 
the beep.

Step 3 Click the add another action prompt to add a second action.

Figure  339  Example 5: Entering the Second Action
The Action Properties dialog box appears.

Step 4 Choose Inject RD Error as the second action.

Step 5 Click the add another action prompt to add a third action.

The Action Properties dialog box appears.

Step 6 Choose Monitor/Count as the third action.
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Step 7 Click OK to close the Action Properties dialog box.

Figure  340  Example 5: Complete Scenario
Step 8 In the File menu, select Save Scenario to save the scenario. 

This example sets the counter to increment at each occurrence of an ACK 
(every 1 ACK). 
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Example 6: Using Timers
In this example, the Global Rules portion of the scenario waits for an ACK primitive 
from the initiator. Each time the device detects an ACK, it injects an RD Error into the 
traffic stream. This state continues for a random period of time, not to exceed 1.790 
seconds. After the time period has elapsed (timer times out), the scenario stops.

Although this example sets the timer for a random period, you also can set the timer 
for known values (2 ms., 5 mins., 1 hr., and so on).

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 As in previous examples, configure the first event and its response in the 
Global Rules area. Choose ACK primitive as the event and Inject RD Error as 
the action.

Step 3 Click the prompt to add another event (keep in mind this is not a combined 
event).

Figure  341  Example 6: Entering the Second Event
The Event Properties dialog box appears.

Step 4 In the Type column on the left, choose Timer. Set the timer for random timing 
with a maximum time limit of 1.790 seconds.

Step 5 Click OK to close the Event Properties dialog box.
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Step 6 Click the prompt to add an action to correspond with the second event. 

Figure  342  Example 6: Entering Second Action
The Action Properties dialog box appears.

Step 7 In the Type list on the left, choose Stop Scenario as the action that you want 
after the timer has expired.

Step 8 Click OK to close the Action Properties dialog box.

Figure  343  Example 6: Complete Scenario
Step 9 In the File menu, select Save Scenario to save the scenario.
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Creating a Sequence
This section gives several examples for creating sequences. Recall that a sequence 
can have multiple states, but only one state is active at any time. In other words, at 
any point in time, a sequence “waits” for one event (or combined event) and responds 
with the corresponding action or set of actions when the event occurs. 

A sequence is more powerful than Global Rules, because you can create branching or 
looping test logic with a sequence.You can include up to two sequences in a scenario, 
but each is completely independent of the other. There is no branching or other 
interaction between the two, except through the Restart All Sequences action.

You must follow some simple rules when creating sequences:

Sequence Rules

The following table summarizes the examples that follow.

Sequence Examples

You can use only two branch actions per state. 
When you specify actions for a state, you can only use two instances of Branch to an Existing 
State or Branch to a New State. If you try to use more than two, a red error message appears in the 
status area of the application that says “Too Many Actions.”

You can use only one restart sequence action per state. 
When you specify actions for a state, you can only use one instance of Restart Current Sequence 
or Restart All Sequences. If you try to use more than one, a red error message appears in the 
status area of the application that says “Too Many Actions.”

You can use a maximum of 255 states per sequence. 
If you try to use more than 255 states, a red error message appears in the status area of the 
application.

Example Description

7 Creating two sequences and Global Rules: This scenario has two objectives that 
you implement with Global Rules and two sequences. 1) You use Global Rules to 
replace any of three types of primitives. 2) You use two sequences to detect the order 
in which a type of frame is received from initiator and target.

8 Creating a sequence with many states #1: The objective of this scenario is to detect 
an incorrect order of primitives and to cause the device to beep when it happens. You 
implement this scenario with a single five-state sequence.

9 Creating a sequence with many states #2: This scenario is an enhancement of 
example 8. In this scenario, the objective is to detect an incorrect order of primitives, fix 
it, and cause the device to beep when this happens. As with example 8, you implement 
this scenario with a single five-state sequence. 
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Example 7: Creating Two Sequences and Global Rules
In this example, Global Rules substitute an Align (0) primitive for each of the following 
received from the initiator: Align (1), Align (2), and Align (3). As a separate test 
operation, two sequences determine the order in which each Identify Address frame is 
received from initiator and target.

The following tables summarize the logic implemented by each of the sequences.
Example 7: Logic of Sequence 0

Example 7: Logic of Sequence 1

There is no interaction between the two sequences. Each of them operates 
independently (and is independent of the Global Rules). However, the two sequences 
complement each other with their logic. In this sense, they both combine to implement 
a test objective.

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 As in previous examples, create the Global Rules area.

Step 3 Click the prompt to add a sequence. Prompts for the sequence appear 
beneath the Global Rules area. You create a sequence one state at a time. The 
application numbers states consecutively from 0 up (1, 2, 3, and so on).

Figure  344   Example 7: Adding a Sequence

State Description

State 0 If Address Frame is detected from initiator, go to State 1; 
otherwise, continue to check incoming frames (do not change state).

State 1 If next Address Frame detected is from target, beep 1 second.

State Description

State 0 If Address Frame is detected from target, go to State 1; 
otherwise, continue to check incoming frames (do not change state).

State 1 If next Address Frame detected is from initiator, beep 2 seconds.
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By default, the name of the first sequence in a scenario is Sequence 0. The name of 
the first state is State 0. To change the name of a sequence or state, or to associate a 
description with it, click the name of the sequence or state. A dialog box appears that 
allows you to enter that information.

Note:  The description does not appear on screen, but you can bring it up by 
clicking the name of the sequence or state.

Step 4 In the State 0 area, click the prompt to add an event.

Figure  345   Example 7: Adding an Event for the First State
The Event Properties dialog box appears.

Step 5 In the Event Properties dialog box, select Address Frame as the event.

Step 6 Click OK to close the Event Properties dialog box.
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Step 7 In the State 0 area, click the prompt to add an action.

Figure  346  Example 7: Adding an Action for the First State
The Action Properties dialog box appears

Step 8 For the action, select Branch to > New State.

Step 9 Click the OK button to close the Action Properties dialog box. 

This saves the action and automatically creates an area for State 1 in the scenario. 

Step 10 In the State 1 area, click the prompt to add an event. The Event Properties 
dialog box appears.

Step 11 Choose the Address Frame event. In the Direction column, select 
From Target (you want State 1 to trigger on an Identify Address frame 
received from the target). 

Step 12 Click OK to close the Event Properties dialog box.
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Step 13 Click the prompt to add an action for State 1. 

Figure  347  Example 7: Adding an Action to the Second State
The Action Properties dialog box appears. 

Step 14 In this example, you enter the action Beep, and you set the duration of the 
beep for 1 second.

Step 15 Click OK to close the Action Properties dialog box.
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Step 16 You are finished creating the first sequence. Click the add another sequence 
prompt to create an area in the scenario for the second sequence 
(Sequence 1).

Figure  348  Example 7: Adding a Second Sequence
Step 17 Create two states in the second sequence with the characteristics shown in the 

following table.

Example 7: States for Second Sequence

State Event Action

0 Address Frame from Target Branch to State 1

1 Address Frame from Initiator Beep for 2 seconds.
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Step 18 In the File menu, select Save Scenario to save the scenario.

Figure  349  Example 7: Sequence Area of Scenario
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Example 8: Creating a Sequence With Many States #1
In this example, a five-state sequence detects if a group of primitives is received  
out-of-order from the initiator. The expected order is: Align (0), Align (1), Align (2), 
Align (3). If this scenario detects any other order of these primitives, it causes the 
device to beep and the scenario to restart.

This example is designed to give you an idea of the powerful logic that you can 
implement with sequences.

Note that the states in this sequence have been renamed (do not have their default 
names). The following table summarizes the sequence logic.

Example 8: Logic of Sequence 0

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 As in previous examples, create the five states for this sequence.

State Description

Wait for Align (0) When an Align (0) is received, go to Wait for Align (1).

Wait for Align (1) If an Align (1) is received next, go to Wait for Align (2); 
otherwise, go to Indicate Error.

Wait for Align (2) If an Align (2) is received next, go to Wait for Align (3); 
otherwise, go to Indicate Error.

Wait for Align (3) If an Align (3) is received next, restart test; 
otherwise go to Indicate Error.

Indicate Error Indicate error and restart test.
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Step 3 In the File menu, select Save Scenario to save the scenario.

Figure  350  Example 8: Top Half of Scenario
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Figure  351  Example 8: Bottom Half of Scenario
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Example 9: Creating a Sequence With Many States #2
In this example, a five-state sequence not only detects if a group of primitives is 
received out-of-order, but it fixes any incorrect order. The logic is similar to that of 
example 8 with a few small changes. The following table summarizes each state.

Example 9: Logic of Sequence 0

Step 1 Click the New Scenario button in the main library or one of the device libraries. 
In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change.

Step 2 As in previous examples, create the five states for this sequence.

State Description

Wait for Align (0) When an Align (0) is received, go to Wait for Align (1).

Wait for Align (1) If an Align (1) is received next, go to Wait for Align (2); 
otherwise, replace primitive with Align (1) and go to Indicate Error.

Wait for Align (2) If an Align (2) is received next, go to Wait for Align (3); 
otherwise, replace primitive with Align (2) and go to Indicate Error.

Wait for Align (3) If an Align (3) is received next, restart test; 
otherwise, replace primitive with Align (3) and go to Indicate Error.

Indicate Error Indicate error and restart test.
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Step 3 In the File menu, select Save Scenario to save the scenario.

Figure  352  Example 9: Top Half of Scenario
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Figure  353  Example 9: Bottom Half of Scenario
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Downloading Scenarios
After you have created a scenario, you need to download it to the Infusion device for 
execution.

If you use a general library as a scenario archive, then the process of creating and 
downloading a scenario is as follows:

Step 1 Open the general library (Main library or a File library). Scenarios in the library 
are listed in the Main Library window.

Step 2 Open the Device Library window by clicking the Show Device Library button 
on application toolbar.

Step 3 Open the Device Library for the device to which you want to download a 
scenario or scenarios. You can open the device library in two ways: by clicking 
the Device Library icon in the device list window or by double-clicking the 
device name.

Step 4 Copy the scenario from general library to device library by dragging it with the 
mouse. 

Step 5 Download all scenarios in the device library to the Infusion device. To do so, 
click the Download all Scenarios button on the Device Library toolbar 
(second button from left).

Running Scenarios
If you use a general library as a scenario archive, then the process of executing a 
scenario is as follows:

Step 1 Select the scenario to run by clicking it. 

Step 2 To run the scenario, click the Run Scenario button on the Device Library 
toolbar (second button from the right). The Infusion device then begins its 
session.
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Appendix A
Creating a Pattern Generator File

You can use any text editor or word processor to create a 
pattern generator file (*.spg), using the following conventions:

Keywords
• ALIGN
• CONT
• DMAT
• EOF
• HOLD
• HOLDA
• PMACK
• PMNAK
• PMREQ_P
• PMREQ_S
• R_ERR
• R_IP
• R_OK
• R_RDY
• SOF
• SYNC
• WTRM
• X_RDY
• XXXX
• LOOP
• Enable
• Disable
• Host
• Device
• Scramble
• Role
• END_OF_FILE

Comment Format
/*Comment text*/

Primitive Definition Format
To add an ALIGN primitive, use ALIGN or 27.3 10.2 10.2 K28.5 
To add a CONT primitive, use CONT or 25.4 25.4 10.5 K28.3

Loop Definition Format
You can write a defined pattern into memory repeatedly by enabling a loop. 
Loop definition allows either “Enable” or Disable”.  
To enable looping, use: Loop=Enable
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Scramble Definition Format
Scramble definition allows either “Enable” or Disable”.  
To enable scramble, use: Scramble=Enable

Role Definition Format
To specify SATA hardware role, use: Role=Host or Role=Device

END_OF_FILE Definition
A pattern generator file must include END_OF_FILE as the last statement in the file.

Example Pattern Generator File
Figure 354 illustrates a typical Pattern Generator file.

Figure  354  Example Pattern Generator File *spg
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Appendix B
China Restriction of Hazardous Substances Table

The following tables are supplied in compliance with China’s Restriction of Hazardous 
Substances (China RoHS) requirements: 
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